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Préface

1. À propos de Mandriva Linux

Mandriva Linux est une distribution GNU/Linux développée par Mandriva S.A. La société Mandriva est née sur In-
ternet en 1998 ; son ambition première demeure de fournir un système GNU/Linux convivial et facile à utiliser.
Les deux piliers de Mandriva sont le logiciel libre et le travail collaboratif.

Note : Le 7 avril 2005, la société Mandrakesoft a modifié son nom pour refléter sa fusion avec Conectiva, leader
GNU/Linux du Brésil. Par conséquent, le produit phare Mandrakelinux a lui aussi changé de nom pour Mandriva Linux.

1.1. Communiquer avec la communauté Mandriva Linux

Nous présentons ci-dessous plusieurs liens Internet pointant vers les ressources liées à Mandriva Linux plus
importantes. Si vous souhaitez en savoir plus sur la société Mandriva, consultez le site Web de Mandriva (http:
//www.mandriva.com/). Vous pouvez aussi visiter le site dédié à la distribution Mandriva Linux (http://www.
mandriva.com/linux) et à tous ses dérivés.

Mandriva Expert (http://www.expert.mandriva.com/) est la plate-forme d’aide en ligne de Mandriva. Elle
propose une nouvelle façon de partager les savoirs, basée sur la confiance et le plaisir de récompenser son
prochain pour son aide.

Vous êtes également invité à participer aux nombreuses listes de diffusion (http://www.mandriva.com/fr/
mailing_lists), où la communauté Mandriva Linux déploie tout son enthousiasme et sa vivacité.

Enfin, n’oubliez pas de vous connecter sur la page sécurité (http://www.mandriva.com/security/) (en an-
glais). Ce site rassemble tout ce qui traite de la sécurité des distributions Mandriva Linux. Vous y trouverez
notamment des avertissements de bogues et de sécurité, ainsi que des procédures de mise à jour du noyau,
les différentes listes de diffusion concernant la sécurité auxquelles vous pouvez souscrire et Mandriva Online
(https://online.mandriva.com/). Ce site est incontournable pour tout administrateur système, ou tout uti-
lisateur soucieux de sécurité.

1.2. Rejoignez le Club

Mandriva Club est l’espace de rencontre, où les utilisateurs se retrouvent pour s’entraider, échanger de pré-
cieuses informations sur Mandriva Linux, s’informer des dernières nouvelles concernant Mandriva, Linux, et
l’Open Source. Les membres du Club ont un accès privilégié à une gamme de services plus étendue.

Grâce votre identifiant Mandriva (obtenu gratuitement en s’inscrivant sur My Mandriva (https://my.
mandriva.com/register), vous bénéficiez :

• d’aide (forums, chat, Base de Connaissance contenant des tutorials, de mini-guides, de trucs et astuces

• d’actualités

• et de plus de contenus conçus par Mandriva et la communauté

En tant que membre du Club, vous accédez en exclusivité à :

• 50 000 paquetages rpm, y compris des logiciels commercialisés, des pilotes, des démos...

• des serveurs de téléchargement ultra-rapides ;

• la documentation officielle de Mandriva Linux ;

• Mandriva Online Services, à savoir : Kiosk, Online, Expert et eTraining ;

• des réductions spéciales en permanence au Mandriva Store ;

• ... et bien plus encore !

C’est au Club Mandriva que vous pouvez faire l’expérience la plus enrichissante de Mandriva Linux : en
apprenant des autres, en montrant aux autres, en accédant à des fonctionnalités exclusives et contribuant au
développement de Mandriva Linux et de l’Open Source en général.
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1.3. S’abonner à Mandriva Online

Afin d’éviter la présence de bogues ou de failles de sécurité, Mandriva vous propose un moyen com-
mode de mettre à jour votre système automatiquement. Visitez le site Mandriva Online (https://www.
mandrivaonline.com//) pour en savoir plus sur ce service.

1.4. Acquérir des produits Mandriva

Vous pouvez acheter des produits Mandriva en ligne sur le Mandriva Store (http://store.mandriva.com).
Vous y trouverez non seulement des solutions Mandriva Linux, des systèmes d’exploitation et des CD de dé-
marrage « live » (comme MandrivaOne), mais aussi des offres spéciales d’abonnement, de l’assistance, des
logiciels tiers, des manuels et des livres GNU/Linux, ainsi que d’autres gadgets Mandriva.

1.5. Le Mandriva Kiosk

Le Mandriva Kiosk est un service qui met à votre disposition un catalogue des logiciels les plus populaires,
qu’ils soient libres ou commerciaux, pour votre distribution Mandriva Linux. Vous y trouverez des nouveaux
logiciels : depuis la dernière version de la suite OpenOffice.org, en passant par des applications multimédia,
aux derniers environnements KDE et GNOME, des jeux et des fonds d’écran.

Le Mandriva Kiosk est très facile à utiliser grâce à son interface Web, ses descriptions détaillées des applica-
tions, et une procédure d’installation simple et rapide permettant de mettre à jour et d’ajouter de nouvelles
fonctionnalités à votre système en quelques minutes. L’installation de nouveaux logiciels sur votre distribution
Mandriva Linux n’a jamais été aussi facile !

Les utilisateurs des distributions Mandriva Linux 2007 : Discovery, Powerpack et Powerpack+ bénéficient gra-
tuitement de 30 jours d’accès à Kiosk, avec la période d’essai au Club. Découvrez Kiosk maintenant sur le site
de Mandriva Kiosk (http://kiosk.mandriva.com).

Le service Mandriva Kiosk est gratuit pour tous les membres du Club, vous pouvez également y accéder sans
faire partie du Club, au moyen d’une souscription annuelle. En vous abonnant au Kiosk, vous obtenez :

• l’accès à un catalogue virtuel de nouveaux logiciels (libres et commerciaux), facile à utiliser

• des paquetages empaquetés et testés exclusivement pour le Kiosk par les équipes Mandriva

• des paquetages qui s’installent aisément et directement sur votre système

• des paquetages qui s’installent en un seul clic !

Appréciez l’expérience Kiosk!

1.6. Contribuer à Mandriva Linux

Quels que soient vos talents, vous êtes encouragé à participer à l’une des nombreuses tâches requises à la
construction du système Mandriva Linux :

• Paquetages. Un système GNU/Linux est principalement constitué de programmes rassemblés depuis Inter-
net. Ils sont mis en forme de façon à fonctionner ensemble;

• Programmation. Une foule de projets est directement développée par Mandriva : trouvez celui qui vous
intéresse le plus et proposez votre aide au développeur principal ;

• Internationalisation. vous pouvez nous aider à traduire les pages de nos sites Internet, les programmes et
leur documentation respective.

Consultez la page des projets de développement (http://qa.mandriva.com/wiki) pour en savoir plus sur les
différentes façons de contribuer à l’évolution de Mandriva Linux.
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2. À propos de ce mini-guide d’installation

Le but de ce guide est de vous présenter les fonctionnalités uniques de Mandriva One, et d’une manière
générale, de vous aider à utiliser et administrer votre système. Que vous soyez un nouvel utilisateur de Linux
ou un utilisateur expérimenté, vous trouverez ici des informations utiles pour maîtriser complètement votre
système.

Démarrez votre système. Votre produit est un CD ou DVD « live », c’est-à-dire, que vous pouvez l’utiliser
directement sans avoir à l’installer sur votre ordinateur. Nous allons donc vous guider dans les quelques
étapes préliminaires nécessaires pour mettre en place votre système.

Utilisez votre système. Si vous êtes un nouvel utilisateur de Linux, vous vous sentirez peut-être comme un
étranger dans un nouveau pays. Nous allons vous guider dans votre nouvel environnement et vous vous
sentirez bientôt chez vous.

Profitez de vos périphériques. Vous voulez utiliser votre imprimante, votre scanner, ou votre webcam ? Rien
de plus facile ! Mandriva Linux supporte la plupart des périphériques et propose d’excellentes applications
pour en profiter au maximum.

Détendez-vous. Mandriva Linux n’est pas seulement fait pour travailler ! Elle offre une gamme complète de
jeux pour tous les goûts. Nous avons sélectionné les meilleurs pour vous.

Installez votre système et partagez-le avec vos amis. Vous allez vite adopter Mandriva Linux et vous l’utiliserez
plus souvent que vous ne le pensez. Nous vous montrons comment l’installer sur votre disque dur pour de
meilleures performances, et comment en faire facilement des copies pour vos amis et vos proches.

3. Démarrage du CD Live MandrivaOne Live CD

MandrivaOne vous permet d’utiliser un système Mandriva Linux entièrement fonctionnel, avec des outils bu-
reautiques, Internet, multimédia et même des jeux, à partir du CD/DVD sans avoir besoin d’installer quoi
que ce soit sur l’ordinateur : tous les logiciels s’exécutent depuis le CD/DVD.

Vous pouvez utilisez MandrivaOne pour essayer Mandriva Linux avant de l’installer, pour travailler sans « tou-
cher » au système d’exploitation déjà installé sur l’ordinateur ni à vos fichiers, ou encore pour réparer un
système endommagé.

Veuillez consulter Partagez et installez votre système Linux, page 53 pour plus d’informations.

3.1. Démarrage du CD

Assurez vous que votre ordinateur est configuré pour démarrer à partir du lecteur de CD-ROM, insérez le CD
de MandrivaOne et redémarrez l’ordinateur. Veuillez vous reporter à la documentation de votre ordinateur si
vous avez besoin de plus d’informations sur comment configurer le démarrage à partir du CD-ROM.

Quelques paramètres (langue, pays, configuration du clavier, fuseau horaire, etc.) doivent être configurés à
chaque démarrage. Il vous suffit de sélectionner vos préférences parmi la liste proposée. Veuillez noter que :

• Si vous sélectionnez l’option Je refuse à l’écran des conditions d’utilisation de la licence : vous ne pourrez
pas utiliser MandrivaOne, l’ordinateur s’éteint quand vous cliquez sur Quitter.

• Après avoir sélectionné le fuseau horaire, vous devez indiquer si votre horloge système est réglée sur l’heure
GMT (Greenwich Mean Time). En cas de doutes, répondez Non.

3.2. Mots de passe par défaut

La distribution « Live » est configurée de telle sorte que ni l’utilisateur par défaut (guest) ni l’administrateur
(root) n’ont de mot de passe. Pour la plupart des manipulations aucun mot de passe ne sera donc demandé,
mais si cela arrivait, laissez les donc vides.
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Chapitre 1. Découvrir votre nouvel environnement

MandrivaOne vous fournit un environnement complet qui rend possible presque tout ce que vous pouvez
imaginer. Dans ce chapitre, nous nous concentrons sur l’utilisation d’Internet (Utiliser Internet, page 5), de
la bureautique (Effectuer des tâches bureautiques, page 14), et des applications multimédias (Multimédia, page
21). Nous détaillerons la configuration et l’utilisation de base de ces applications, tout en vous invitant à
l’exploration.

1.1. Utiliser Internet

MandrivaOne est un outil excellent pour utiliser Internet. Dans cette section, nous vous montrons comment
gérer vos courriers électroniques avec KMail, naviguer sur le Web avec Konqueror et discuter avec vos amis et
collègues grâce à Kopete.

1.1.1. Envoyer et recevoir du courrier électronique

À partir du menu principal, choisissez Internet→Messages+KMail pour lancer KMail. Un assistant de
configuration apparaît alors.

1.1.1.1. Configuration de la messagerie électronique

Figure 1-1. Type de compte

Sélectionnez le type de compte de messagerie dans la liste et allez à l’étape suivante. La configuration des
comptes IMAP et POP3 est identique.

Figure 1-2. Informations sur le compte

Veuillez entrer votre nom, votre adresse électronique et le nom de votre société.
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Figure 1-3. Informations sur le compte

Entrez votre identifiant de messagerie ainsi que le mot de passe associé. Votre FAI ou votre administrateur
système a dû vous fournir ces informations en même temps que votre adresse email.

Figure 1-4. Serveurs de courriers

Enfin, il vous faut fournir les paramètres de serveur de courrier. Encore une fois, votre FAI ou votre
administrateur système a dû vous fournir les noms des serveurs de courriers entrants et sortants. Le
nom du serveur pour l’envoi des courriers est généralement de la forme smtp.fournisseur.net.
Pour la réception, les serveurs POP3 ont généralement un nom de la forme pop.fournisseur.net ou
pop3.fournisseur.net. Quant aux serveurs IMAP pour la réception du courrier, ils sont généralement
de la forme imap.fournisseur.net. La forme mail.fournisseur.net est aussi courante pour les ser-
veurs de courriers entrant et sortant.
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Chapitre 1. Découvrir votre nouvel environnement

1.1.1.2. Interface du client de messagerie

Liste des dossiers

Barre d’outils

Liste de messages

Volet des
messages

Figure 1-5. Interface de Kmail

Barre d’outils. Les boutons associés aux actions principales se trouvent ici. Voir tableau 1-1.

Liste de messages. Les informations (sujet, date, expéditeur, etc.) au sujet des messages stockés dans le dossier
actuellement sélectionné sont affichées à cet endroit.

Volet des messages. Le contenu du message sélectionné s’affiche ici.

Liste des dossiers. Tous vos dossiers y sont énumérés. Les dossiers par défaut sont Boîte de réception
(messages entrants), Boîte d’envoi (messages en attente d’envoi), Messages envoyés (messages déjà
envoyés), Corbeille (messages effacés), et Brouillons. Un répertoire spécial nommé Recherches con-
tient les résultats des recherches effectuées.

1.1.1.3. Utilisation de KMail

Le tableau suivant montre et décrit les boutons les plus importants qui sont disponibles dans la barre d’outils
de KMail. Il mentionne également leurs raccourcis clavier respectifs et explique leurs fonctions.

Bouton Raccourci clavier Fonction

Ctrl-N Composer un nouveau message. Vous devez remplir les champs À
et Objet dans la fenêtre de rédaction de message.

Ctrl-L

Récupérer les messages pour tous les comptes de courrier définis.
Si vous maintenez ce bouton enfoncé, une liste de tous vos
comptes sera affichée. Sélectionnez celui pour lequel vous désirez
uniquement récupérer les messages.

R Répondre à l’auteur du message sélectionné. Une fenêtre de
composition s’affichera. Quelques champs seront déjà remplis.

F Transmettre (envoyer à un tiers) le message sélectionné.
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Bouton Raccourci clavier Fonction

Del

Effacer les messages sélectionnés. Les messages effacés seront
déplacés dans le dossier Corbeille. Vous pouvez récupérer ces
messages, mais il est impossible de récupérer les messages qui
auront été effacés depuis la Corbeille : faites attention !

Tableau 1-1. Boutons de la barre d’outils de KMail

Note : Certains de ces boutons sont munis d’une petite flèche noire située en bas à droite. Elle indique qu’un menu
abritant des actions supplémentaires peut être affiché en cliquant sur le bouton de la souris un peu plus longtemps.

1.1.2. Naviguer sur Internet

Choisissez Internet→Navigateurs Web +Konqueror dans le menu principal, pour lancer Konqueror. La
page d’accueil s’affiche alors. Ensuite, tapez une adresse Internet dans la barre d’adresse (nommée
Emplacement).

1.1.2.1. Interface du navigateur Internet

Barre d’outils

Barre d’adresse

Zone
d’affichage

Barre de
signets

Onglets de

navigation

Figure 1-6. Interface de Konqueror

Barre d’outils. Où se trouvent les boutons vous permettant de naviguer et d’accomplir les tâches communes
(voir tableau 1-2).

Barre d’adresse. Où vous saisissez les adresses des sites (ou des fichiers locaux, en remplaçant http:// par
file:// en début d’URL).

Barre de signets. Où se trouvent les boutons qui vous permettent d’accéder rapidement à vos sites favoris.

Navigation par onglets. Vous permet de consulter plusieurs sites dans le même fenêtre au lieu d’en ouvrir
plusieurs, ce qui rend la navigation bien plus aisée.

Zone d’affichage. Où s’affiche le contenu de la page Web ou des fichiers locaux que vous voulez consulter.

8



Chapitre 1. Découvrir votre nouvel environnement

1.1.2.2. Naviguer sur Internet

Bouton Raccourcis clavier Fonction

Alt-flèche gauche
Précédent. Retourne à la page affichée avant celle actuellement
visitée. Gardez le bouton enfoncé pour afficher la liste des pages
précédemment visitées.

Alt-flèche droite
Suivant. Retourne à la page que vous avez visitée après celle
actuellement visible. Les mêmes considérations que celles
exposées pour le bouton « Précédent » s’appliquent.

F5

Recharger. Actualise la page en cours. Par défaut, Konqueror utilise
la page disponible dans son cache (espace disque temporaire).
Appuyez sur la touche Shift lorsque vous cliquez sur ce bouton
pour forcer Konqueror à récupérer la page depuis Internet.

Esc Arrêter. Arrête le transfert des objets demandés et, par la même
occasion, annulera le chargement de la page demandée.

Tableau 1-2. Boutons de la barre d’outils de Konqueror

Le navigateur Web Konqueror vous permet de consulter de nombreuses pages Web dans la même fenêtre en
utilisant une fonctionnalité nommée « navigation par onglets ».

Cliquez sur ce bouton (ou Ctrl-Shift-N) pour créer et ouvrir un nouvel onglet. Entrez une adresse Inter-
net dans la barre d’adresse pour visualiser la page dans le nouvel onglet.

Astuce : Vous pouvez également taper Ctrl-Shift-D pour dupliquer l’onglet courant , c’est-à-dire ouvrir une nouvelle fois
la page sur laquelle vous êtes, mais dans un nouvel onglet. Ceci est pratique pour les pages très longues, vous permettant
ainsi de lire en même temps deux sections différentes d’une même page.

Ferme l’onglet actuellement affiché (Ctrl-W).

Pour retrouver vos sites favoris où que vous soyez, il est recommandé d’utiliser des sites de marque-pages
mutualisés comme Del.Icio.Us (http://del.icio.us), par exemple.

1.1.3. Discuter avec des amis ou collègues

Sélectionnez Internet→Messagerie instantanée +Kopete à partir du menu principal pour lancer Kopete.
Un assistant apparaît.
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1.1.3.1. Configurer Kopete

Figure 1-7. Sélection du service de messagerie

Avec Kopete, vous pouvez discuter avec des personnes qui utilisent MSN, Yahoo, ICQ, IRC, etc. Choisissez un
des services de messagerie dans la liste et passez à l’étape suivante. Gardez en tête que chaque service de
messagerie possède ses propres paramètres de configuration. Nous vous montrons ici comment configurer
une service de messagerie instantanée, ainsi qu’un compte IRC.
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Figure 1-8. Informations sur le compte

Ensuite, vous devez fournir des informations sur le compte : au minimum un identifiant (ou une adresse
électronique) et un mot de passe; mais certains services peuvent nécessiter plus d’informations. Référez-vous
à la documentation de votre service de messagerie instantanée pour obtenir plus d’informations sur les para-
mètres de connexion à remplir.

Astuce : La plupart des services de messagerie propose un bouton Créer un nouveau compte, vous permettant d’obtenir
un compte de ce service, si vous n’en avez pas.

Le dernier écran de l’assistant vous invite à vous connecter au service de messagerie. Décochez la case Connec-
ter maintenant si vous désirez vous connecter plus tard.

Choisissez Configurations→Configurer dans le menu, puis sélectionnez la section Comptes et cliquez sur le bou-
ton Nouveau pour configurer un nouveau compte de messagerie. Nous allons maintenant ajouter un compte
pour le serveur IRC irc.freenode.net et le canal de discussion #mandrivafr, où vous trouverez de l’aide
pour votre système MandrivaOne grâce à d’autres utilisateurs de Mandriva Linux.
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Figure 1-9. Configuration IRC Basique

Entrez un pseudonyme 1 ainsi qu’un pseudonyme alternatif (au cas où quelqu’un aurait déjà enregistré celui
que vous avez choisi). Si vous le désirez, vous pouvez ajouter un nom d’utilisateur et un mot de passe.

Astuce : Généralement, le pseudonyme alternatif est le même pseudonyme suffixé d’un _.

Figure 1-10. Paramètres de serveur IRC

1. Dans les canaux de discussions IRC, votre identifiant est le pseudonyme que vous avez choisi.
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Ensuite, choisissez l’onglet Connexion et sélectionnez un serveur IRC dans la liste déroulante Réseau. Vous
pouvez également choisir le jeu de caractères par défaut ainsi que d’autres options. Passez à l’étape finale et
quittez l’assistant.

1.1.3.2. Interface de Kopete

Liste de contacts

Barre d’outils

Services

Figure 1-11. Interface de messagerie instantanée

Barre d’outils. Les principaux boutons d’actions se trouvent ici. Voir tableau 1-3.

Liste de contacts. Chacun de vos contacts y possède une entrée spécifique et une icône indiquant le protocole
utilisé. L’état de vos contacts est indiqué de cette manière :

•

Le contact est connecté et disponible ;

•

le contact est connecté mais non disponible. Selon le protocole utilisé, vous pouvez quand même lui envoyer
des messages, qu’il lira lorsqu’il sera à nouveau disponible ;

•

le contact n’est pas connecté, vous ne pouvez pas lui envoyé de messages. Remarquez que vous ne pouvez
voir ce statut que si vous avez choisi d’afficher les contacts non connectés.

État des services. Chaque service de messagerie configurée possède une icône. Si cette icône est colorée, cela
signifie que vous êtes connecté au service. Sinon, il apparaît en gris. Faites un clic droit sur une icône pour
obtenir un menu spécifique au service de messagerie choisi.
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Bouton Fonction

1.1.3.3. Discuter avec Kopete

Bouton Fonction

Régler l’état. Affiche une liste d’état possibles lorsque vous êtes connecté. Choisissez celui
que vous désirez dans la liste. Gardez à l’esprit que l’état sera appliqué à tous vos services
de messagerie configurés.

Ajouter un contact. Choisissez le service de messagerie dans la liste, puis entrez
l’identifiant de votre contact. Vous pouvez également l’assignez à un groupe. Cliquez sur
OK pour l’ajouter à votre liste.
Les services de messagerie les plus populaires (MSN, Yahoo, ICQ, Jabber, etc.) enregistrent
la liste de vos contacts sur leur serveur, par conséquent vous conservez votre liste de
contacts, où que vous soyez.

Quand vous cliquez sur ce bouton, les utilisateurs non connectés apparaissent dans votre
liste. Cette option est pratique pour visualiser tout les contacts de votre liste selon le
service de messagerie utilisé.

Tableau 1-3. Boutons de la barre d’outils de Kopete

Pour commencer une discussion avec un de vos contacts, double-cliquez simplement sur son nom dans la liste.
Une fenêtre divisée en deux apparaît. Dans la partie inférieure, tapez votre texte, la conversation s’affiche dans
la partie supérieure.

IRC est un peu différent, vous devez d’abord rejoindre un canal de discussion sur un serveur. Un canal est une
salle de discussion avec un sujet spécifique. Pour rejoindre un canal :

1. Cliquez sur l’icône d’état IRC.

2. Choisissez l’entrée Rejoindre un canal.

3. Tapez le nom du canal dans la boîte de dialogue. Les noms de canaux commencent avec un dièse (#),
#mandrivafr par exemple.

4. Une fenêtre similaire aux autres services de messagerie apparaît. Sur la droite, remarquez la liste des
utilisateurs connectés à ce canal. Si aucune liste n’est présente, vous êtes la seule personne connectée.
Changez de canal ou attendez que quelqu’un le rejoigne.

Répétez la même opération pour rejoindre d’autres canaux du même serveur IRC. Une nouvelle fenêtre
s’affiche pour chaque canal, ce qui vous permet de suivre plusieurs discussions à la fois.

Il existe beaucoup de références à la « netiquette » sur Internet, qui décrit les normes et les règles comportemen-
tales à appliquer lorsque l’on discute avec d’autres. Vous pouvez effectuer une recherche sur « chat netiquette »
(sur Google) (http://www.google.fr/search?q=chat+netiquette) pour obtenir plus d’informations. (chat
est le terme anglais pour bavarder (sur Internet)).

1.2. Effectuer des tâches bureautiques

MandrivaOne vous permet d’utiliser des applications bureautiques comme la suite OpenOffice.org. Les appli-
cations OpenOffice.org sont compatibles avec Microsoft® Office, ce qui signifie que vous pouvez échanger des
documents entre ces deux suites. Nous vous expliquons comment créer des documents avec OpenOffice.org
Writer, des feuilles de calcul avec OpenOffice.org Calc et des présentations avec OpenOffice.org Impress.
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1.2.1. Écrire des documents

Choisissez Bureautique→Traitements de texte+OpenOffice.org Writer à partir du menu principal, pour lancer
OpenOffice.org Writer.

1.2.1.1. Interface de traitement de texte

Barre de mise en forme

Règles

Point
d’insertion

Style
de page

Aire de
travail

Figure 1-12. La fenêtre principale d’OpenOffice.org Writer

Barre de mise en forme

Voici la barre de mise en forme standard pour toutes les applications OpenOffice.org. Elle est utilisée pour
changer les types de police, les couleurs, l’alignement, etc.

Règles

Elles définissent la position horizontale du texte et des éléments de mise en page. Elles sont très utiles
lorsque vous voulez régler des tabulations ou des indentations de paragraphe.

Aire de travail

Espace où vous entrez le contenu de votre document : mots, nombres, images, tableaux, hyperliens, etc.

Point d’insertion

Tous les caractères que vous tapez sont placés à gauche de ce point. Le point d’insertion est également
appelé curseur.

Style de page

La taille de la page, les marges, l’orientation du texte, etc., définissent le style d’un document. Le style
de page peut être modifié par l’entremise du menu Format→Page. Vous pouvez utiliser un des styles
prédéfinis ou en personnaliser un vous-même.

1.2.1.2. Styles

De manière générale, les utilisateurs de traitement de texte perdent beaucoup de temps à formater leur do-
cument (changer l’alignement des paragraphes, le type de police, la taille du document, etc.) au lieu de se
concentrer sur leur structure et leur contenu.

L’utilisation de styles permet une approche mettant l’accent sur la structure, tout en normalisant le
formatage et la mise en page d’un document. Elle facilite aussi la génération et l’entretien d’une table
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des matières (TDM), d’un index, d’une bibliographie, etc. Sous OpenOffice.org Writer, les styles sont
gérés par l’entremise du Styliste. Cliquez sur son icône dans la barre de mise en forme pour l’ouvrir ou le
fermer.

Lorsque vous voulez utiliser... Appliquez le Style...

Titre de chapitre Titre 1

Titre de section Titre 2

Titre de sous-section Titre 3

Titre de sous-sous-section Titre 4

Paragraphe Corps de texte, Alinéa

Élément de liste Liste

Tableau 1-4. Styles suggérés

Utilisez les styles décrits dans tableau 1-4, en tant que guide. Choisissez la région du document à laquelle vous
voulez appliquer un style précis et, dans la fenêtre du Styliste, double-cliquez sur le style de votre choix.

1.2.1.3. Listes

Utilisez des listes pour énumérer les propriétés d’un objet (liste « non ordonnée » ou « à puce »), ou pour
décrire les étapes nécessaires pour accomplir une tâche donnée (liste « ordonnée » ou « numérotée »).

Cliquez sur ce bouton pour transformer le texte sélectionné en liste non ordonnée. Pour modifier le
type de puce : sélectionnez les éléments de la liste et cliquez sur le menu Format→Numérotation/puces.

Cliquez sur ce bouton pour transformer le texte sélectionné en liste ordonnée. Les mêmes règles que
pour les listes non ordonnées s’appliquent en ce qui concerne le format de numérotation.

1.2.1.4. En-têtes et pieds de page

Par défaut, ils sont communs à toutes les pages d’un document. Utilisez-les pour décrire certains aspects du
contenu d’un document, par exemple, le numéro de page, le nombre total de pages, le titre d’un chapitre ou
d’une section, le titre d’un document, etc.

Choisissez Insertion+En-tête→Standard depuis le menu pour ajouter une en-tête ou Insertion+Pied de page→
Standard pour un pied de page. Tapez un texte pertinent pour l’un et l’autre de ces composants ou utilisez une
ou plusieurs entrées du menu Insertion→Champ pour composer des en-têtes et des pieds de page.

1.2.1.5. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Writer, vous pouvez télécharger
ce tutoriel (http://fr.openoffice.org/Documentation/Guides/parcours_texte_ooo.pdf)2.

N’hésitez pas non plus à vous reporter à l’aide en ligne de OpenOffice.org Writer, accessible par le menu Aide→
Aide OpenOffice.org, ou en appuyant sur la touche F1. Vous y trouverez la réponse à toutes vos questions.

Astuce :

OpenOffice.org Writer est capable d’exporter vos documents au format PDF (en choisissant le menu Fichier→
Exporter au format PDF). Cela permet de communiquer vos documents dans le célèbre format Adobe® Rea-
der®.

2. Notez que pour lire un fichier au format PDF vous aurez besoin d’un logiciel adapté (Kpdf par exemple)
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1.2.2. Calculs et simulations

Sélectionnez Bureautique→Tableurs+OpenOffice.org Calc dans le menu principal, pour lancer OpenOffice.org
Calc.

1.2.2.1. Interface de tableur

Barre de
mise en forme

Aire de
travail

Sélectionner
tout

Barre de
formule

Onglets des
feuilles de calcul

Figure 1-13. La fenêtre principale d’OpenOffice.org Calc

Barre de mise en forme

Il s’agit de la barre de mise en forme commune à toutes les applications OpenOffice.org pour modifier la
police, la couleur, l’alignement, etc. des données de l’application.

Barre de formule

Utilisez cette barre pour écrire ou modifier une formule dans une cellule.

Aire de travail

La feuille de calcul proprement dite sur laquelle entrer et afficher les données : nombres, dates, formules,
images, etc.

Sélectionner tout

Cliquez sur cette zone située dans le coin supérieur gauche de la zone de travail pour sélectionner toutes
les cellules d’un seul coup. C’est utile si vous désirez appliquer des changements « globaux » sur toute la
feuille. Par exemple, en changeant la taille des polices à 10pts (points).

Boutons et onglets de changement de feuille

Un document de feuilles de calcul comporte généralement plusieurs feuilles. Utilisez ces boutons pour
naviguer facilement d’une feuille à l’autre. De gauche à droite nous avons : Aller à la première feuille, Aller
à la feuille précédente, Aller à la feuille suivante et Aller à la dernière feuille. Vous pouvez aussi utiliser les
onglets.
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1.2.2.2. Saisie de données

Pour saisir des données dans une cellule, allez dans la cellule, tapez vos données et appuyez sur la touche
Entrée.

La fonctionnalité de complètement automatique facilite l’entrée de données. Le programme essaye de « de-
viner » les données à insérer dans la cellule suivante en fonction de la cellule courante. Cela fonctionne pour
tout type de données correspondant à une série d’entiers.

Pour utiliser le complètement automatique, placez votre souris au-dessus de la « poignée » de la cellule (le
petit carré noir situé sur le coin inférieur droit du bord de la cellule), cliquez dessus et glissez la cellule. La
valeur des cellules sera affichée dans une bulle. Relâchez le bouton de la souris et les cellules seront remplies.

Les cellules peuvent aussi être triées en fonction de divers critères. Sélectionnez la zone de cellules que vous
souhaitez trier puis ouvrez le dialogue de tri en choisissant le menu Données→Trier. Spécifiez le critère, l’ordre
et les options additionnelles puis cliquez sur OK.

Astuce : Assurez-vous de sélectionner aussi les cellules qui servent d’en-tête aux données (dans notre exemple la
colonne B qui contient le nom des mois) de façon à ce que celles-ci suivent aussi le tri des données.

1.2.2.3. Ajout de formules

Les formules sont utilisées pour « automatiser » la feuille de calcul ce qui vous permet, par exemple, de lancer
des simulations. Dans les cellules, les formules sont définies en rentrant le signe =. Tout le reste est traité
comme des données « statiques ».

Les opérations sont décrites en utilisant la notation algébrique conventionnelle. Par exemple =3*A25+4*(A20+C34/B34)
divise la valeur de la cellule C34 par celle de la cellule B34, ajoute la valeur de la cellule A20 au résultat, mul-
tiplie ce dernier par 4 puis ajoute 3 fois la valeur de la cellule A25. Ainsi, des expressions assez complexes
peuvent être simplifiées en utilisant des expressions plus simples à la base.

OpenOffice.org Calc propose un grand nombre de fonctions prédéfinies utilisables dans les formules. Explorez
toutes ces fonctions en choisissant le menu Insertion→Fonction.

1.2.2.4. Diagrammes : présentation graphique des données

Lorsqu’une feuille de calcul contient beaucoup d’informations, il devient difficile de cerner les relations entre
les différents types de données : trop de chiffres et pas assez de sens. La meilleure façon de représenter ces
données est d’utiliser des graphiques.

Comme pour toutes les fonctions d’analyse de données, il faut préalablement sélectionner les données que
vous souhaitez afficher dans le diagramme. Sélectionnez donc une zone de cellules, puis choisissez le menu
Insertion→Diagramme pour afficher l’assistant de création de diagrammes.

Choisissez le type, la variante, le titre, les titres d’axe, etc. de votre graphique et cliquez sur Créer pour créer et
insérer le graphique dans la feuille de calcul.

Astuce : Les diagrammes sont actifs dans la feuille de style, et s’adaptent automatiquement lorsque vous modifiez les
valeurs des cellules affichées dans le diagramme.

Astuce : Un double-clic, puis un clic droit sur un diagramme fait apparâıtre un menu avec des options permettant de
changer de nombreux paramètres de ce diagramme.
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1.2.2.5. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Calc, vous pouvez télécharger ce
tutoriel (http://www.framasoft.net/article1294.html) (en format PDF).3.

N’hésitez pas non plus à vous reporter à l’aide d’OpenOffice.org Calc accessible par le menu Aide→Aide
d’OpenOffice.org, ou en appuyant sur la touche F1. Vous y trouverez la réponse à toutes vos questions.

1.2.3. Présenter vos idées

Choisissez Bureautique→Présentations+OpenOffice.org Impress à partir du menu principal, pour lancer Ope-
nOffice.org Impress. Un assistant vous aide à créer une présentation, nous ne détaillerons pas cet assistant,
cliquez juste sur le bouton Créer pour créer une présentation vierge.

1.2.3.1. Interface du logiciel de présentations

Barre d’outils

Aire de
travail

Mise en forme des transparents

Modèles

Aperçu des
transparents

Figure 1-14. La fenêtre principale d’OpenOffice.org Impress

Barre de mise en forme

Elle comprend des options qui permettent de définir les ombres des diapositives, la couleur d’arrière-
plan, l’épaisseur des lignes, etc.

Aire de travail

Où vous composez les diapositives de votre présentation.

Barre d’outils

Elle contient les outils principaux permettant de concevoir les diapositives, tels que l’outil texte, les for-
mes, les courbes, les lignes et les flèches ; les outils de rotation d’objet, d’effets spéciaux ; etc.

Astuce : Certains de ces boutons ont un petit triangle sur le côté. En appuyant sur ceux-ci, vous ouvrirez un menu
contenant des options spécifiques à cet outil. Par exemple, insérer un rectangle (plein ou vide), avec des rebords
courbés ou droits, etc.

3. Notez que pour lire un fichier au format PDF vous avez besoin d’un logiciel adapté (Kpdf par exemple)
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Volet Tâches

Ici, vous trouvez plusieurs modèles de présentations disponibles. Sélectionnez celui que vous voulez pour
transformer la diapositive courante.

Volet Diapos

Affiche la liste des diapositives composant la présentation. Les diapositives affichées sont miniaturisées
de manière à voir rapidement ce à quoi elles ressemblent. Pour modifier une diapositive, cherchez-la dans
la liste et cliquez dessus.

1.2.3.2. Ajouter des diapositives à votre présentation

Cliquez sur ce bouton dans la barre d’outils ou choisissez Insertion→Diapo dans le menu pour ajouter
une diapositive, avec le modèle de document actuel.

Astuce : Choisissez Insertion→Dupliquer la page si vous préférez vous appuyer sur la diapositive courante.

1.2.3.3. Diagrammes simples

Sélectionnez Insertion→Diagramme depuis le menu pour en insérer un dans la diapo active. Une barre
de diagramme « standard » sera insérée et OpenOffice.org Impress passera en mode Diagrammes.
Cliquez à l’extérieur de la zone de diagramme pour revenir en mode édition de diapositive.

Vous pouvez ajuster la taille du diagramme en cliquant sur les bordures. Double-cliquez sur le diagramme
puis faites un clic droit sur celui-ci et choisissez Données du diagramme. Une fenêtre (figure 1-15) apparaîtra
vous permettant d’entrer les données du diagramme que vous voulez créer.

Figure 1-15. Saisir les données du diagramme

Une fois que vous aurez entré les données dans le diagramme, fermez la fenêtre de saisie de données et cliquez
sur Oui pour actualiser votre diagramme dans la diapo. Puis cliquez sur une aire vide de la diapo.

Répétez l’opération de double-clic et de clic droit afin de changer le titre, la légende, l’axe, le type (2D ou 3D),
la barre, le camembert, les points, les lignes, etc., du diagramme en choisissant les entrées appropriées depuis
le menu contextuel.
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1.2.3.4. Arrière-plan de diapo

Utilisez le menu Format→Page et cliquez sur l’onglet Arrière-plan pour définir les couleurs, les dégradés, les
hachures, etc. de votre diapo. Chaque type d’arrière-plan possède ses propres options, explorez-les.

Note : L’utilisation de bitmap en arrière-plan augmente considérablement la taille d’un fichier. Ceci pourrait ralentir
fortement votre présentation, surtout sur les vieux systèmes.

Une fois que vous aurez choisi un arrière-plan, vous pourrez choisir de définir cet arrière-plan en standard
pour toutes les diapositives. Faites votre choix et l’arrière-plan des diapositives sera actualisé.

1.2.3.5. Transitions, animations et effets

Le menu Diaporama permet d’appliquer des transitions, des animations et des effets pour dynamiser vos pré-
sentations. Essayez cependant de ne pas abuser de ces effets spéciaux. Ils pourraient distraire votre public et
détourner leur attention vers les effets en tant que tel, au détriment de votre message.

1.2.3.6. Lancer votre présentation

Vous pouvez lancer votre présentation par l’entremise du menu Diaporama→Diaporama, ou en appuyant sur
la touche F5. La présentation s’affichera sur tout votre écran. Pour l’arrêter, appuyez sur la touche Échap.

1.2.3.7. Pour aller plus loin

Si vous souhaitez en apprendre plus sur le fonctionnement de OpenOffice.org Impress, vous devriez consul-
ter le tutoriel disponible sur le site français d’OpenOffice.org, à la rubrique documentation (http://fr.
openoffice.org/Documentation/How-to/indexht.html).

N’hésitez pas non plus à vous reporter à l’aide en ligne de OpenOffice.org Impress accessible grâce au
menu Aide→Aide de OpenOffice.org ou en appuyant sur la touche F1. Vous y trouverez la réponse à
toutes vos questions.

1.3. Multimédia

Avec MandrivaOne, vous pouvez lire des CDs, DVDs, des fichiers audio et vidéos et graver des CDs et des
DVDs. Vous pouvez également utiliser des logiciels de retouche d’images pour améliorer vos photos, celles
que vous aurez copié de votre appareil photo, par exemple.

1.3.1. Jouer de la musique

1.3.1.1. CD audio

Lorsque vous insérez un CD audio dans votre lecteur, une boîte de dialogue s’affiche. Si vous choisissez de
jouer le CD, le lecteur KsCD démarre .
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Figure 1-16. Interface principale de KsCD

Astuce :

Une fois que KsCD est lancé, cette icône apparâıt à côté de l’horloge. Faites un clic droit dessus pour accéder aux
fonctionnalités de KsCD.

À gauche se trouvent les commandes classiques d’un lecteur CD : Lecture/Pause, Arrêter, Éjection, etc. Celles
qui se trouvent en dessous modifient l’ordre de lecture. Le bouton CDDB donne des informations sur le disque
en cours de lecture, comme le titre de l’album, le nom de l’artiste et le titre de la chanson jouée. Un dernier
bouton permet d’afficher plus d’options de configuration avancées.

1.3.1.2. Fichiers audio

Choisissez Multimédia+Son→Amarok à partir du menu principal pour lancer Amarok.

Liste de lecture
Navigateur

Contrôle du
volume

Contrôles de
lecture

Figure 1-17. Fenêtre principale d’amaroK

La figure 1-17 montre les différents composants d’Amarok :

Navigateur. Affiche des informations selon la fonction sélectionnée dans les onglets à gauche.

Liste de lecture. Où les pistes à jouer sont affichées. Un clic gauche sur une des pistes vous permet d’accéder
à un menu pour jouer la piste, la retirer de la liste de lecture, etc.

Contrôles de lecture. Les contrôles de lecture d’Amarok sont « standards » : Piste Précédente/Suivante,
Lecture, Arrêt. Le bouton Lecture sert aussi à mettre en pause. Appuyez longtemps sur le bouton Arrêt pour
choisir si l’arrêt doit s’effectuer immédiatement ou après que le morceau en cours soit fini.

Contrôle du volume. Faites glisser vers la droite pour augmenter le volume et sur la gauche pour le diminuer.
Un clic droit dessus et un menu s’affiche dans lequel vous pouvez choisir l’Égaliseur pour améliorer la balance
des basses et aigus ou choisir des présélections.
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Le navigateur de Collection vous permet de visualiser et organiser votre bibliothèque musicale. Pour
l’utiliser, il vous faut créer une collection : Construction de la collection, cochez les répertoires où
Amarok cherchera des fichiers audio et cliquez sur Ok pour commencer le référencement.

Avertissement

Si vous avez ajouté des fichiers contenus sur des périphériques amovibles (tels que des clés USB ou un disque
dur externe), assurez-vous qu’ils sont montés de la même façon que lorsque vous avez bâti votre collection. Sinon
Amarok sera incapable de trouver les fichiers qu’ils abritent.

Puis, commencez à ajouter des pistes à la liste de lecture en double-cliquant sur celles que vous voulez dans
le navigateur de collection. Une fois satisfait de votre liste de lecture, cliquez simplement sur le bouton

(Lecture) et profitez de votre musique.

1.3.2. Graver des CD/DVD

Nous traitons essentiellement de l’utilisation de K3b pour effectuer des opérations classiques de gravure de
CD; la gravure de DVD étant similaire.

Matériel sous copyright. Notez que la copie de CD/DVD audio, vidéo ou de données est souvent interdite par des lois
sur le copyright. Nous partons du principe que si vous souhaitez dupliquer des données sous copyright, c’est parce que
vous en avez le droit.

En choisissant Administrer votre système→Graver des CD/DVD depuis le menu principal, vous démarrerez K3b.
Voici l’interface de K3b (figure 1-18) avec un nouveau projet de données ouvert.

Barre d’outils

Gestionnaire

de fichiers

Gestionnaire

de projet

Figure 1-18. L’interface de K3b

Barre d’outils. Où vous trouverez les boutons pour effectuer les tâches courantes : ouvrir et enregistrer des
projets, effacer des supports ré-inscriptibles, copier des CDs, etc.
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Gestionnaire de fichiers. Pour sélectionner les fichiers à graver sur le CD. Utilisez l’arborescence de gauche
pour naviguer dans l’arborescence locale, et glissez-déposez les fichiers à graver dans le gestionnaire de projet.

Gestionnaire de projet. Endroit où les fichiers à graver sont gérés. Les fichiers peuvent y être effacés et leur
emplacement (le répertoire dans lequel ils résident) sur le CD peut être modifié.

1.3.2.1. Graver un ensemble de fichiers ou de répertoires

Choisissez Fichier→Nouveau projet→Nouveau projet de CD de données depuis le menu de K3b . Ensuite, glissez
les fichiers ou répertoires à inclure sur le CD dans le gestionnaire de projets (voir figure 1-19).

Figure 1-19. Choisir les fichiers et les répertoires à inclure sur le CD

Note : Ajouter des répertoires contenant beaucoup de fichiers peut prendre du temps. Veuillez patienter et attendre que
le message Ajout des fichiers au Projet NOM_DU_PROJET disparaisse.

L’espace qu’occupent les fichiers et répertoires sera représenté par une barre de couleur située au bas du
gestionnaire de projets. Vous verrez aussi l’espace en terme de Mo ainsi que la capacité disponible en Mo.
Voici ce que signifient les couleurs :

Vert

La taille de l’ensemble des fichiers est inférieure à la capacité maximale du support (700 Mo par défaut).
Il n’y a pas de problèmes relatifs à la capacité.

Jaune

La taille de l’ensemble des fichiers équivaut presque à celle du support. S’il ne s’agit que de quelques Mo
sous la capacité maximale, il n’y aura pas de problèmes. Toutefois, si la taille de l’ensemble des fichiers
excède légèrement celle du support, il est possible que la gravure s’effectue avec succès, mais rien n’est
certain.
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Rouge

La taille de l’ensemble des fichiers excède de beaucoup celle du support. Le CD ne sera pas gravé correc-
tement.

En faisant un clic droit sur n’importe quel fichier ou répertoire situé dans le gestionnaire de projets, un menu
contextuel contenant quelques options s’affiche. Ces options permettent d’effacer ou de renommer les fichiers,
de créer de nouveaux répertoires (vides), etc. Les fichiers et les répertoires peuvent être déplacés sur le CD en
faisant un glisser-déposer (drag-and-drop).

Astuce : Si vous renommez l’élément racine de l’arborescence de gauche du gestionnaire de projets, cela change le nom
de volume du CD (K3b data project par défaut pour les CD de données).

En choisissant l’entrée de menu Projet→Graver, une fenêtre s’affiche depuis laquelle vous pourrez choisir les
paramètres de gravure (voir figure 1-20). Insérez un support inscriptible dans le graveur de CD et cliquez sur
Graver.

Figure 1-20. Régler les paramètres de gravure

1.3.2.2. Graver des CD audio (CDDA)

Par CD audio, nous entendons des CD que vous pouvez écouter dans le lecteur de votre auto ou à la maison
sur votre chaîne HI-FI, et non des CD de données contenant des OGG, MP3 ou tout autre format de fichier
audio compressé.

K3b prend en charge l’enregistrement de CD audio depuis des pistes digitalisées en format Wav (*.wav), Ogg
Vorbis (*.ogg) et MP3 (*.mp3). Vous pouvez mélanger les formats audio digitaux. K3b décompressera à la
volée ceux qui sont compressés. K3b peut aussi extraire et compresser des pistes audio depuis des CD audio.

Choisissez Fichier→Nouveau projet→Nouveau projet de CD audio depuis le menu de K3b. Sélectionnez le type
de Filtre du gestionnaire de fichiers pour ne garder que les fichiers sonores, naviguez jusqu’à l’emplacement
des fichiers audio , puis glissez-déposez les pistes audio dans le gestionnaire de projets (voir figure 1-21).
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Figure 1-21. Choix des pistes audio à inclure sur le CD

Déplacez les fichiers dans l’ordre qui vous plaît avec la souris. Une fois vos pistes compilées dans l’ordre
désiré, vous pouvez les graver sur un CD.

1.3.3. Regarder des films

1.3.3.1. Fichiers vidéos

Choisissez Multimédia→Vidéo+Kaffeine dans le menu principal pour lancer Kaffeine. Un assistant ap-
paraît lors de la première utilisation de Kaffeine, acceptez simplement les paramètres proposés.
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Zone d’affichage

Statut

Controle du voluume

Barre latérale

Commandes
 de lecture

Contrôle
 de position 

Figure 1-22. Interface de Kaffeine

L’interface de Kaffeine est très simple (figure 1-22) et composée des éléments suivants :

Barre latérale. La barre latérale vous permet d’accéder à d’autres fenêtres de Kaffeine : vous pouvez ainsi voir
le menu de démarrage de Kaffeine, écouter des CDs, une liste de lecture, et regarder des DVDs.

Commandes de lecture. Un ensemble réduit des commandes d’un magnétoscope : Précédent, Lecture/Pause
(raccourci clavier : Barre d’espace), Stop (raccourci clavier : Backspace) puis Suivant.

Zone d’affichage. La zone où la vidéo est lue. Pressez les touches Ctrl-Shift-F pour basculer entre les modes
fenêtre et plein écran.

Statut. Située en bas à droite de la fenêtre Kaffeine, cette ligne donne des informations sur la liste de lecture et
la vidéo jouée.

Pour lire un fichier vidéo, choisissez Fichier→Ouvrir pour ouvrir un dialogue standard vous permettant de
choisir le film que vous voulez voir, sélectionnez-le et cliquez sur Ouvrir, le film commence immédiatement.

1.3.3.2. DVD

Lorsque vous insérez un DVD vidéo dans votre lecteur, LinDVD le joue automatiquement. figure 1-23 vous
montre l’interface de LinDVD composée de deux parties : une fenêtre de lecture, comme un écran de télévision
et une fenêtre de commandes similaires à celles d’un lecteur DVD classique.
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Figure 1-23. Interface de lecteur DVD

1.3.4. Studio de photos numériques

Choisissez Multimédia→Graphisme+digiKam dans le menu principal pour lancer digiKam. Lors de
la première utilisation, vous devrez assigner un répertoire par défaut pour l’enregistrement des
images. Vous pouvez accepter le répertoire par défaut /home/votre_identifiant/Images.

1.3.4.1. Créer un album photo

Choisissez Album→Créer un album dans le menu et remplissez les propriétés de l’album (voir figure
1-24), puis acceptez les paramètres pour créer l’album.
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Figure 1-24. Propriétés du nouvel album

Choisissez Album+Importer→Ajouter des images dans le menu puis sélectionnez les images pour en-
richir votre album photo et cliquez sur Ajouter.

Astuce : Vous pouvez ajouter toutes les images d’un répertoire donné en choisissant l’option Album+Importer→Importer
des dossiers dans le menu et sélectionnez des répertoires plutôt que des images.

1.3.4.2. Orientation des photos

Sélectionnez une image et cliquez sur Image+Corriger l’orientation EXIF dans le menu si l’image n’est pas orien-
tée dans le bon sens.

Beaucoup d’appareils photo enregistrent l’orientation de la prise de vue dans le fichier image, ce qui s’appelle
« orientation EXIF ».

Avertissement

Toutes les modifications sur les images (telles que la rotation) sont effectuées sur les images du disque. digi-
Kam n’effectue pas de copie de sauvegarde de l’image d’origine. Cependant, à chaque fois que c’est possible, les
transformations se font sans perte.

1.3.4.3. Retouche d’images

Faites un double-clic sur une image pour ouvrir la fenêtre d’édition. Notez que toutes les opérations de re-
touche affectent la qualité du fichier de la photo sur le disque. Gardez aussi à l’esprit que le rendu des couleurs
à l’écran est différent de celui obtenu lors de l’impression de vos photos. De sorte que si vous envisagez à la
fois l’impression et la publication en ligne de vos photos, mieux vaut faire une copie de l’image avant toute
chose.

Astuce : Pressez Ctrl-Z pour annuler la dernière transformation. Cependant une fois que l’image a été enregistrée, les
changements ne peuvent plus être annulés.
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Luminosité, contraste et gamma

Choisissez le menu Corriger+Couleurs→Luminosité/Contraste/Gamma et utilisez les curseurs pour ajuster ces
paramètres de l’image, en utilisant l’aperçu pour vous guider.

Netteté

Choisissez Corriger→Rendre l’image nette, déplacer le pointeur sur la partie de l’image à utiliser comme guide,
et utilisez le curseur pour modifier la netteté de l’image.
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Correction des yeux rouges

Avant Après

Sélectionnez à l’aide de la souris la pupille de l’œil à corriger, choisissez Corriger→Corriger les yeux rouges dans
le menu, puis choisissez une option de correction suivant les indications données. Répétez l’opération pour
chaque oeil.

Résolution et redimensionnement d’image

Les images de plusieurs mégapixels sont parfaites pour l’impression sur papier photo, mais ne conviennent
pas pour l’envoi par courrier électronique ou la publication sur le Web. Choisissez dans le menu Transformer→
Redimmensionner, ensuite sélectionnez la taille voulue, soit en pixels ou en pourcentage. Choisissez aussi de
garder (recommandé) ou non l’aspect ratio.

Vous pouvez aussi redimensionner une image à une taille voulue en gardant l’aspect ratio. Choisissez
Transformer→Recadrer selon un ratio depuis le menu, glissez le carré pour cadrer la partie de l’image qui vous
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intéresse et sélectionnez l’aspect ratio, l’orientation, la largeur et la hauteur (l’un suit l’autre selon l’aspect
ration choisi).

Astuce : Pour une publication au format électronique, le ratio d’affichage est généralement de 4:3, alors que pour
l’impression on utilise plutôt du 3:2.

Une taille de 640x480 est généralement suffisante pour envoyer une photo par courrier électronique, et du 800x600
suffit à de la publication Web.
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Une fois que votre session « Live » est lancée, vous pouvez utiliser vos périphériques tels que imprimante,
scanner, webcam ou appareil photo numérique, etc. Mandriva Linux est reconnue comme une des distri-
butions Linux les plus abouties grâce à la reconnaissance d’un grand nombre de matériels. Si vous ren-
contrez des problèmes commencez par consulter la Liste de matériel compatible Mandriva Linux (http:
//www.mandriva.com/hardware/).

2.1. Le centre de contrôle Mandriva Linux

Le Centre de contrôle Mandriva Linux est un outil de configuration et de paramétrage du système d’exploitation.
Le Centre de contrôle Mandriva Linux rend la configuration des périphériques très simple, lorsqu’elle n’est pas
entièrement automatisée.

Dans ce chapitre, nous utiliserons quelques-uns des outils dédiés aux périphériques que le Centre de contrôle
Mandriva Linux offre. Lancez le Centre de contrôle Mandriva Linux en sélectionnant le menu Menu princi-
pal+Système+Configuration→Configurez votre ordinateur.

Dans ce chapitre, nous utiliserons les outils de la section Matériel.

Figure 2-1. Outils matériel

2.2. Configuration de l’imprimante

La configuration des imprimantes est facilitée, voire automatisée, grâce à des outils graphiques qui détectent
et installent les applications nécessaires au fonctionnement de l’imprimante.

Astuce : Si vous installez un périphérique HP Tout en un (imprimante, scanner, fax), assurez-vous que l’installation
s’effectue avec HPLIP, une solution complète pour la gestion de toutes les fonctionnalités des imprimantes jet d’encre
ou laser HP.
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Une fois que l’imprimante est configurée, les applications pourront commencer à imprimer. Voici quelques
exemples :

• La suite OpenOffice : traitement de textes, tableur, présentation, base de données, éditeur d’équations et outil
de dessin.

• Le GIMP : un outils de manipulation d’image.

• showPhoto : un outil de gestion de photographies.

• Konqueror le gestionnaire de fichiers et navigateur Web de KDE.

2.2.1. Installer une imprimante

La procédure qui suit vous guide pour l’installation de l’imprimante. Avant de commencer, assurez-vous que
l’imprimante est connectée au port parallèle ou USB de l’ordinateur et allumée.

Installer un imprimante

1. Démarrer le Centre de contrôle Mandriva Linux.

2. Cliquez sur l’onglet Matériel.

3. Cliquez sur l’outil Configurer la/les imprimante(s).

La détection d’imprimante commence alors pour les imprimantes locales et distantes.

4. Lorsqu’un dialogue vous demande si vous souhaitez permettre l’impression sur les imprimantes dé-
tectées, cliquez sur Oui.

Attendez que le processus d’installation se termine.

5. Une fois que la liste des imprimantes détectées s’affiche, cochez la case Ne plus configurer l’imprimante
automatiquement, puis cliquez sur le bouton Ok.

6. Un avertissement indique que la configuration automatique a été désactivée, cliquez sur Ok pour confir-
mer.

Le reste de la procédure est automatique. Selon l’imprimante installée, d’autres messages de configuration
peuvent apparaître. Suivez les instructions affichées. Le processus se termine par l’affichage de l’interface
principale de gestion. La nouvelle imprimante installée est dans la liste et activée.
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2.2.2. Configurer une imprimante

Les nouvelles imprimantes installées sont configurées d’après les paramètres par défaut du pilote et de la
configuration régionale du système.

Configurer une imprimante

1. Sélectionnez l’onglet Configurée(s) sur cette machine de l’interface principale.

2. Sélectionnez l’imprimante à configurer puis cliquez sur le bouton Éditer.

Le dialogue Modifier la configuration de l’imprimante s’affiche. Dans cet exemple, nous allons changer le
paramètre Page size de l’entrée Options de l’imprimante.

3. Le dialogue Paramètres par défaut de l’imprimante s’affiche.
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4. Choisissez la taille de papier souhaitée dans la liste déroulante Taille de la page, puis cliquez sur Ok.

Gestion des imprimantes et des travaux dans KDE : Les paramètres d’impression par défaut peuvent aussi être modifiés
à partir du Centre de contrôle KDE (Menu principal+Système+Configuration→Centre de configuration de KDE) puis
Périphériques→Imprimantes.

2.2.3. Tester une imprimante

Testez vos imprimantes juste après leur installation, ou après avoir modifié les paramètres ou changé l’encre.

Tester une imprimante

1. Sélectionnez l’imprimante à tester et cliquer sur le bouton Éditer.

2. Sélectionnez l’entrée Imprimer des pages de test, puis cliquez sur Faire!.

3. Sélectionnez une ou plusieurs pages de test, puis cliquez sur le bouton Imprimer.

Les pages de test sont envoyées à l’imprimante, et une fois imprimées, des messages d’état indiquent le
résultat.

4. Cliquez alors sur Ok.
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Vous retournez au dialogue de configuration, depuis lequel vous pourrez éventuellement continuer à
configurer et tester l’imprimante.

Si la page de test ne s’imprime pas correctement, vérifiez les paramètres et testez à nouveau.

Astuce : Il est aussi possible de tester une imprimante à partir du centre de contrôle de KDE, comme vu précédemment.

Affichez le Centre de configuration KDE, puis Périphériques→Imprimantes. Sélectionnez l’imprimante à tester, puis
Imprimantes→Tester l’imprimante. Cliquez sur Imprimer la page de test.

Bien que cette interface ne permette pas d’imprimer de page de test photo, elle permet de contrôler la liste des tâches
d’impression en cours.

2.3. Configurez votre Scanner

Note : Si vous installez un périphérique Tout en un , vous devez le configurer comme indiqué dans la Configuration
de l’imprimante, page 33 avant de lire cette section.

Plusieurs applications permettent de capturer les images directement depuis un scanner, par exemple :

• Le GIMP : un outil de manipulation d’images.

• Kooka : un programme d’acquisition d’images.

• OpenOffice.org - Writer : un traitement de textes.

2.3.1. Installer un Scanner

Un scanner est généralement connecté à l’ordinateur par un port USB. Toutefois, certains scanners sont connec-
tés par une interface parallèle, ou SCSI.

Connectez votre scanner, puis allumez-le. Démarrez alors le Centre de contrôle Mandriva Linux, puis allez dans
la section Matériel.

Installer un scanner

1. Cliquez sur l’icône Configurer le numériseur (scanner).

L’application va parcourir votre système à la recherche de scanners connectés.

2. Une fois cette recherche terminée, une liste des périphériques trouvés est affichée. Votre scanner est installé
et configuré selon les paramètres par défaut. Cliquez sur Quitter.
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2.3.2. Tester un scanner

Pour tester le scanner nous allons simplement scanner un document à l’aide d’un outil dédié, en l’occurrence
Kooka.

Tester un scanner

1. À partir du menu principal, sélectionnez Multimédia→Graphisme→Kooka.

L’assistant de configuration de Kooka s’affiche avec la liste des scanners disponibles.

2. Sélectionnez le scanner à tester puis cliquez sur Ok.

3. Placez un document dans le scanner, puis cliquez sur le bouton Aperçu.

Le scanner préchauffe puis acquiert l’image qui est alors affichée.

Si l’image s’affiche correctement : votre scanner est fonctionnel.
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4. Cliquez sur le bouton Numérisation finale pour sauvegarder l’image.

2.4. Configurez votre Webcam

La plupart des webcams sont connectées à l’ordinateur par un câble USB. Les webcams de meilleure qualité
nécessitent une connection sur un port parallèle. Dans Mandriva Linux, une webcam est considérée comme un
périphérique scanner. Dans la plupart des cas les webcams prises en charge sont automatiquement détectées
et installées.

Avant de continuer, assurez-vous que la webcam est bien connectée à l’ordinateur.

2.4.1. Installation automatisée

Démarrez le Centre de contrôle Mandriva Linux et sélectionnez la section Matériel.

Installer une webcam

1. Cliquez sur l’icône Configurer le numériseur.

L’application de configuration des scanners va rechercher les périphériques installés.
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2. Ensuite, la liste des scanners et tous les périphériques de capture d’image en général sera affichée. Vérifiez
que votre webcam est bien listée.

2.4.2. Testez votre webcam

Pour tester votre webcam nous allons ici utiliser Kopete, un outils de communication compatible avec la plu-
part des autres outils de messagerie instantanée. Il n’est pas nécessaire que vous possédiez un compte de
messagerie instantanée pour tester la webcam, mais vous devrez en avoir un pour pouvoir utiliser la web-
cam en communiquant avec vos interlocuteurs. Pour utiliser un compte de messagerie avec Kopete, consultez
Discuter avec des amis ou collègues, page 9.

Tester une webcam

1. À partir du menu principal, sélectionnez Internet→Instant Messaging→Kopete.

2. Suivez l’assistant pour configurer un de vos comptes existants, ou cliquez sur le bouton Annuler.
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3. Choisissez le menu Configuration→Configurer.

Sélectionnez la section Périphériques pour afficher l’onglet Vidéo qui propose quelques paramètres de confi-
guration et l’image capturée par la webcam.

2.5. Utiliser un appareil photo numérique

Certains appareils photo numériques (APN) sont considérés comme des appareils photos, et d’autres comme
des périphériques de stockage. Ceci a peu d’importance pour ce que nous voulons faire : transférer les photos
de l’appareil sur l’ordinateur.

Connexion et déconnexion de l’appareil photo. La plupart des APNs se connectent à l’ordinateur par un
câble USB. Lorsque vous le connectez, mieux vaut le mettre sous tension après qu’il est relié à l’ordinateur.
Procédez en sens inverse pour la déconnexion, c’est-à-dire : éteindre l’appareil photo avant de le déconnecter.

Appareil photo considéré comme périphérique de stockage

1. Connectez l’APN et allumez-le. Si la fenêtre suivante apparaît, c’est que l’appareil est reconnu comme un
périphérique de stockage. Sinon consultez Transférer et manipuler les photos avec Digikam, page 42.
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2. Cliquez OK, le gestionnaire de fichiers apparaît, affichant le contenu des répertoires de l’appareil photo.
Vous pouvez alors copier les images dans votre dossier personnel pour les retravailler ou simplement les
afficher.

2.5.1. Transférer et manipuler les photos avec Digikam

Le plus facile pour utiliser un APN avec Mandriva Linux est de passer par digiKam, une application de gestion
de vos photos numériques.

Configuration de l’appareil photo

1. Sélectionnez le menu Menu principal→Multimédia→Graphisme→DigiKam pour démarrer digiKam.

Le dialogue du Dossier de la bibliothèque d’albums apparaît.

2. Sélectionnez le dossier dans lequel vous souhaitez enregistrer vos photos, puis cliquez sur Ok pour afficher
l’interface principale de digiKam.
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3. Choisissez l’entrée de menu Appareil photo→Ajouter un appareil photo pour afficher le dialogue de confi-
guration.

4. Cliquez sur Détecter automatiquement.

Votre APN sera désormais dans la liste des Appareils photos. Cliquez sur O pour revenir à l’interface prin-
cipale de Digikam.

Importer vos photos

1. Votre appareil apparaît désormais dans le menu Appareil photo. Sélectionnez l’entrée de menu correspon-
dant à votre APN pour ouvrir la fenêtre des aperçus.
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2. Sélectionnez Transférer→Transférer tout

3. Cliquez sur Nouvel Album, et entrez le nom de votre nouvel album, contenant les photos téléchargées,
cliquez à nouveau sur Ok dans le dialogue de choix de l’album.

4. Toutes les images sont alors transférées de l’appareil à l’album choisi. Cliquez sur Fermer pour retourner
à l’interface principale de digiKam et consulter vos albums et photos.

Digikam est une application complète de manipulation d’images. Pour apprendre à utiliser ses nombreuses
fonctionnalités, consultez The digiKam Handbook (http://docs.kde.org/development/en/extragear-graphics/
digikam/index.html) et The digiKam Image Plugins Handbook (http://docs.kde.org/development/en/
extragear-graphics/digikamimageplugins/index.html) (en anglais).

2.6. Lecteurs de cartes mémoire

Les lecteurs de carte mémoire autorisent des transfert de fichiers à haute vitesse depuis les cartes mémoire
utilisées notamment dans les téléphones portables, assistants personnels (PDA), lecteurs MP3 ou appareils
photos numériques. La quantité de formats gérés d’un lecteur à l’autre varie : cartes SD, MultiMediaCard,
CompactFlash, SmartMedia, Microdrive, MemoryStick, MemoryStick Pro ou encore Memory Stick Duo (avec
adaptateur). Les lecteurs de carte mémoire se connectent à l’ordinateur par un port USB.

En connectant un lecteur, une icône est créée et lui est associée sur le bureau. En outre, une fenêtre de notifica-
tion indique qu’un nouveau support a été détecté.
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Si le lecteur comporte plusieurs cartes connectées en même temps, chaque carte possédera sa propre icône sur
le bureau. Il suffit de double-cliquer sur cette icône pour afficher son contenu dans le gestionnaire de fichiers.
Vous pouvez alors copier ou déplacer les fichiers et dossiers d’un support à un autre, en créer et supprimer à
l’envi.
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3.1. Jeux Linux libres

Comme vous pouvez le voir dans le gestionnaire de logiciels (voir Gestion des paquetages, page 57), Mandriva
Linux propose une grande variété de jeux à installer, classés par catégories.

Figure 3-1. Installer des jeux

La qualité varie radicalement d’un jeu à l’autre, nous vous conseillons donc de les tester et de faire votre choix
selon vos goûts. Nous n’abordons ici que quelques-uns d’entre eux.

3.1.1. Frozen Bubble

• Paquetage : frozen-bubble

• Menu : Autres applications+Jeux+Jeux d’arcade→Frozen Bubble

Le but de ce jeu de type arcade est de tirer des bulles de couleur pour faire des groupes de trois bulles de
la même couleur. Lorsque vous réussissez, ces bulles tombent et vous continuez de tirer avant que le temps
ne s’écoule. Il abrite 100 niveaux en mode mono-joueur ; tentez de finir le niveau plus rapidement que votre
adversaire en mode deux joueurs. La musique stéréo et les effets sonores sont bien réalisés. Ne faites pas
pleurer le petit pingouin en bas de l’écran !

Pendant combien de temps serez-vous accro ?
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3.1.2. Supertux

• Paquetage : supertux

• Menu : Autres applications+Jeux+Jeux d’arcade→SuperTux

Un des jeux les plus intéressants est un clone de Super Mario appelé SuperTux (http://supertux.berlios.
de/). Il met en vedette Tux le Pingouin qui tente de sauver son amoureuse Penny des bras de son ennemi de
toujours, Nolok. La première étape déterminante (milestone) consiste en 26 niveaux et Tux y affronte 9 ennemis
qu’il doit éviter, écraser ou tuer. Vous pouvez aussi essayer les deux niveaux bonus, et même concevoir vos
propres niveaux grâce à l’éditeur de niveau.

3.1.3. X-Moto

• Paquetage : xmoto

• Menu : Autres applications+Jeux+Jeux d’arcade→X-Moto
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Pilotez votre moto tous-terrains sur de beaux et escarpés chemins. Ramassez en route les fruits pour atteindre
votre but : cueillir une belle fleur pour votre bien aimée :-). Une belle simulation et de beaux graphiques
font de ce jeux un excellent divertissement. Choisissez l’un des niveaux prédéfinis, téléchargez-en depuis le
site Internet X-Moto (http://xmoto.sourceforge.net) ou créez vos propres parcours. Il est aussi possible de
sauvegarder votre jeu pour regarder votre parcours par la suite.

3.1.4. Jeux KDE sympas

• Paquetage : kdegames

• Menu : Autres applications+Jeux
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Jeux de plateau

Jouez à des jeux de plateau classiques comme les échecs, le backgammon et bataille navale ! Vous
pouvez jouer à certains de ces jeux en réseau (visitez le site Free Internet Chess Server (FICS) (http:
//www.freechess.org), par exemple).

Cartes

Vous vous ennuyez ? Pourquoi ne pas jouer une petite partie de poker ou de réussite ? Commencez votre
partie de KPoker avec 100 $ et... essayez de ne pas tout perdre !

Stratégie

Passez quelques minutes (ou quelques heures...) à démystifier des jeux tels que K Sokoban, K Atomik ou
Jeu Same.

3.1.5. StepMania

• Paquetage : stepmania

• Menu : Autres applications+Jeux+Arcade→StepMania

Qui a dit que les jeux d’ordinateur ce n’était pas du sport ? StepMania va vous faire transpirer en face de votre
écran.

Pré-requis

• Un bon système de son.

• Un tapis de danse USB.

Installation des chansons

Par défaut StepMania est installé sans chansons. Pour les rajouter, suivez ces instructions.

1. Connectez vous à la section téléchargement de chansons de Stepmania (http://www.stepmania.com/
wiki/Download_Songs), et téléchargez un pack de chansons, en l’ouvrant dans le gestionnaire d’archives.
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2. Créer un répertoire StepMania dans votre dossier personnel, puis décompressez le contenu de l’archive
dedans.

Démarrer le jeu. Tout est prêt ! Démarrez StepMania à partir du menu principal, et suivez les instructions à
l’écran.

3.2. Faire tourner des jeux Windows® sur Mandriva Linux

• Paquetage : cedega

• Menu : Autres applications+Jeux+Transgaming→Cedega

Cedega. Cedega est une application qui permet aux joueurs de lancer des dizaines de jeux Windows® sous
GNU/Linux, comme Battlefield 2, Elder Scrolls IV: Oblivion, World of WarCraft, Civilization IV, Madden 2006 et
beaucoup d’autres1. Si vous avez déjà un jeu que vous utilisez sous Windows®, Cedega va donc vous permettre
de le lancer directement sous Mandriva Linux.

Configuration requise

TransGaming recommande la configuration suivante pour de meilleures performances :

• Suffisamment de place sur le disque dur pour l’installation des jeux, plus 60MB for Cedega

• Carte vidéo 3D de type nVidia GeForce

Assistant de première utilisation

1. Rentrez vos identifiants TransGamer2, et cochez la case Check for Updates.

2. Cochez toutes les cases dans le dialogue des mises à jour, puis installez-les.

3. Changez l’information sur le matériel si nécessaire, mais cela ne devrait pas être nécessaire.

4. Lancez tous les tests systèmes en cliquant sur Run Selected Tests. Cedega fonctionnera mieux si tous les
tests passent avec succès.

Figure 3-2. L’interface principale de Cedega

Installer la traduction française

1. Ouvrez le dialogue Edit→Language preferences.

2. Cliquez sur Install et choisissez la traduction fr.

3. Fermez Cedega et redémarrez le.

1. Consultez la base de données des jeux disponibles (http://transgaming.org/gamesdb/).
2. Consultez les instructions dans votre boîte Mandriva pour obtenir ce compte.
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Figure 3-3. Cliquez sur Installer pour installer un jeu

Installer un jeu supporté à partir du CD ou DVD

1. Insérez le CD ou le DVD et cliquez sur Détecter le disque de jeu.

2. Si cela fonctionne, cliquez sur Continuer et suivez les instructions d’installation du jeu. Sinon, utilisez la
procédure suivante.

Installation non automatique

1. Dans le champ Répertoire du jeu, entrez le nom du jeu à installer, c’est la description qui vous convient.

2. Entrez le chemin d’accès au programme d’installation dans le champs Installeur, ou utilisez le bouton
Parcourir pour sélectionner ce même programme. Le nom de ce programme est souvent setup.exe,
install.exe ou autoplay.exe, et se trouve la plupart du temps dans le répertoire racine du CD. Le
nom peut varier cependant, selon le jeu.

3. Cliquez sur Continuer et suivez les instructions d’installation du jeu.

Jouez! Le jeu apparaît alors dans la colonne de gauche. Sélectionnez-le et cliquez sur Lancer.

3.3. Encore plus de jeux

Si vous voulez en apprendre plus sur les jeux sous GNU/Linux vous pouvez consulter les sites suivants :

Happy Penguin (http://www.happypenguin.org)

Vous trouverez ici une base de données des jeux connus, une FAQ, un forum et une liste des jeux les plus
excitants sous GNU/Linux.

LinuxGames (http://www.linuxgames.com/)

Nouveautés sous Linux

Jeux Libres (http://jeuxlibres.net/)

Catalogue de jeux et nouveautés.

Nekeme prod. (http://www.nekeme.net/)

Association pour le développement de jeux libres.
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Chapitre 4. Partagez et installez votre système Linux

Les procédures suivantes vous aideront à créer facilement une copie de votre CD/DVD pour les distribuer à
votre entourage, ou encore à installer le système sur le disque dur de votre machine en quelques clics.

4.1. Live Copy

Cliquez sur cette icône du bureau pour lancer l’assistant de copie de CD/DVD. Indiquez le support
sur lequel faire la copie : soit cdrom, soit usb1. Vous devez alors insérer ce support et le formater si nécessaire.
Gardez à l’esprit que les supports optiques « -R » n’ont pas besoin d’être formatés. Assurez-vous que le support
est prêt et cliquez sur Terminer pour démarrer la copie.

4.2. Live Install

4.2.1. Copie des fichiers sur le disque

Cliquez sur cette icône du bureau pour démarrer l’assistant d’installation.

1. Où installer le système sur votre disque

Selon le contenu de votre disque, plusieurs choix sont possibles pour l’emplacement du système sur
le disque. Gardez à l’esprit que si vous réutilisez des partitions existantes d’un précédent système
d’exploitation, ou si vous les effacez, vous perdrez les données qui y sont stockées. En sélectionnant
l’option Partitionnement personnalisé, vous pourrez précisément contrôler le partitionnement en utilisant
DiskDrake (voir la section Gérer ses partitions de Guide de démarrage).

2. Copie des fichiers

Le système est alors copié sur le disque, aucune intervention n’est requise. Cela prend plusieurs minutes,
selon la vitesse de votre système.

3. Configuration du chargeur de démarrage

Cette étape installe le menu qui permet de choisir le système à démarrer à l’allumage de la machine.
Vous pouvez accepter les choix par défaut. Cliquez sur Avancé si vous avez besoin de plus d’options de
configuration.

4. Fin

Cliquez sur le bouton Terminer puis redémarrez l’ordinateur (Menu principal+Déconnexion+Redémarrer
l’ordinateur), en enlevant le CD/DVD à la fin du cycle d’arrêt.

4.2.2. Configuration du système

Quelques paramètres doivent maintenant être configurés dès que le système a redémarré.

4.2.2.1. Réseau

Il y a ici deux étapes principales: sélection du type de connexion et configuration des paramètres réseau,
suivant le type de connexion. Assurez-vous de posséder tous les paramètres nécessaires (par exemple : adresse
IP, serveurs DNS, passerelle IP, etc.) : votre fournisseur d’accès ou votre administrateur réseau devrait vous
les avoir fourni.

1. La clé USB doit faire au moins 1Go pour contenir le système.
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Figure 4-1. Choix du type de connexion

Connexion par modem. Sélectionnez le type Modem analogique (RTC).

Modem-cable. Certaines connexions modem-cable correspondent à une connexion Ethernet. Consultez votre fournisseur
d’accès.

Réseaux cellulaires. Pour se connecter à un réseau de téléphone cellulaire, choisissez l’entrée GPRS/Edge/3G.

1. Choix du type de connexion

Votre périphérique réseau est automatiquement détecté selon le type de réseau choisi. Sinon, vous pouvez
choisir le périphérique manuellement.

2. Paramètres réseau

Renseignez tous les paramètres réseau pour la connexion choisie.

3. Contrôle de la connexion

Après que tous les paramètres ont été remplis, il est proposé de démarrer la connexion dès le démarrage
du système ; à moins que vous n’ayez une connexion qui n’est pas censée être permanente, laissez cette
option cochée.

4. Enfin, vous pouvez tester la connexion. Si ça ne marche pas, vous pourrez revenir en arrière et faire les
ajustements nécessaires. Vous êtes désormais connecté au réseau, cliquez sur le bouton Terminer.

4.2.2.2. Mot de passe Administrateur

L’utilisateur root est l’administrateur du système, et peut faire toutes les opérations possibles sur le sys-
tème, mieux vaut donc choisir un bon mot de passe pour protéger le compte root. Ce mot de passe sera
demandé chaque fois que vous voudrez faire une tâche d’administration (comme l’installation de nouveaux
programmes) sur le système.

Choisir un bon mot de passe : Le mot de passe devrait être un mélange de caractères alphanumériques et d’au moins
6 à 8 caractères. N’écrivez pas le mot de passe root. Attention cependant, ce mot de passe ne doit pas être trop long
ou trop compliqué, vous devez pouvoir vous en souvenir !

Le mot de passe n’est pas affiché à l’écran lorsque vous le tapez. Rentrez le deux fois pour confirmation.
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4.2.2.3. Création des comptes utilisateur

Il faut aussi créer un utilisateur non privilégié (ou « normal ») pour l’utilisation courante du système.

1. Remplissez chaque champs, puis cliquez sur Accepter pour créer un premier compte. Notez que si ce mot
de passe n’est pas aussi important que celui de root, c’est tout de même ce mot de passe qui garantit
l’accès à vos données personnelles.

2. Si plusieurs personnes vont utiliser cet ordinateur, créez un compte pour chacune d’entre elles, puis cli-
quez sur Terminer.

4.2.2.4. Assistant d’enregistrement

Que vous ayez déjà un compte Mandriva ou que vous vouliez enregistrer votre nouveau produit, cet assistant
vous permettra de bénéficier de tous les avantages associés. Lisez attentivement les instructions avant de
passer d’une étape à l’autre, ou cliquez sur Ne pas configurer pour ignorer cet assistant.

Une fois cela terminé, le système est prêt à être utilisé. Entrez vos identifiants de connexion pour commencer
à utiliser le système.
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Chapitre 5. Gestion des paquetages

Pour commencer, un peu de vocabulaire.

Paquetage
Les logiciels sont constitués de plusieurs fichiers, pour faciliter leur développement et leur gestion. Au
final, une application consiste en plusieurs morceaux : les binaires, la documentation, les ressources né-
cessaires à l’application (images, icônes, traductions, sons, etc.). Un paquetage est l’ensemble des com-
posants d’une application, rassemblés dans un unique fichier, ce qui en simplifie l’installation, la mise à
jour et la suppression.

Dépendance
Les applications s’appuient sur des librairies logicielles ou des composants, créés par différents déve-
loppeurs, pour exécuter un ensemble de fonctions données, différentes de la fonction principale de
l’application, mais nécessaires pour l’accomplir. Une dépendance est un paquetage dont un autre pa-
quetage a besoin pour fonctionner correctement. L’outil de gestion des paquetages de Mandriva Linux
prend en charge automatiquement toutes les dépendances.

Mise à jour
Un logiciel est vivant : de nouvelles fonctionnalités sont ajoutées, d’autres sont améliorées et des problè-
mes (bogues) sont résolus. Une mise à jour est un paquetage qui apporte quelques-unes ou toutes ces
améliorations et réparations à une application existante. Nous vous recommandons de vérifier les mises
à jour afin de garder votre système en bon état et à l’abri de bogues et autre menaces de sécurité.

Source
Le terme source désigne à la fois un répertoire de paquetages et l’endroit à partir duquel les paquetages
sont installés. Les sources correspondant au support utilisé pendant l’installation du système sont auto-
matiquement créées et vous pouvez ajouter vos propres sources pour les mises à jour et les paquetages
que vous trouvez sur Internet par exemple.

Mandriva Linux utilise le système de paquetage RPM. Mandriva Linux propose des outils pratiques qui sim-
plifient la gestion des logiciels. L’ensemble des outils urpmi s’exécutent par la ligne de commande.. Dans ce
chapitre, nous nous concentrerons sur Rpmdrake : l’outil graphique d’installation de logiciels Mandriva Linux
et sur le Gestionnaire de média. figure 5-1 montre la section Gestion de logiciels de Centre de contrôle Mandriva
Linux.
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Figure 5-1. Gestion d’applications dans le Centre de contrôle Mandriva Linux

Rpmdrake peut être utilisé dans un des trois modes : installation

, suppression

et mise à jour

, expliqués dans Installation, suppression et mise à jour de logiciels, page 58. La gestion des média est traitée
dans Le gestionnaire de médias, page 61.

5.1. Installation, suppression et mise à jour de logiciels

Au lancement de cet outil, il faut patienter quelques secondes pendant que Rpmdrake charge la base de données
des paquetages. Puis, l’interface principale de Rpmdrake apparaît.
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Arbre des 
catégories

Liste des paquetages

Description
 du paquetage

Groupe de
paquetages

Recherche de 
paquetage

Figure 5-2. Interface de Rpmdrake

Groupe de paquetages. Utilisez cette liste déroulante pour sélectionner le type de paquetage à afficher : tous
les paquetages (installés ou non), les paquetages installés seulement (à désinstaller), les paquetages non ins-
tallés seulement (à installer). Quelques options sont aussi disponibles pour les paquetages mis à jour (toutes
les mises à jour, les mises à jour de sécurité, les correction de bogues, les mises à jour normales). Chaque fois
qu’un groupe de paquetages est sélectionné, l’arbre des catégories est reconstruit pour afficher uniquement
les paquetages correspondants.

Recherche de paquetage. Si vous n’êtes pas sûr du nom d’un paquetage, utilisez cet outil pour le chercher.
Entrez la chaîne de caractère à rechercher, sélectionnez le critère en utilisant la liste déroulante et cliquez sur
Rechercher. Vous pouvez rechercher des paquetages par nom (dans noms), par description (dans descriptions)
et par paquetages, en fournissant le nom d’un fichier (dans noms de fichiers).

Note : Si vos répertoires de média logiciels sont configurés pour utiliser les listes résumées de paquetages (les fichiers
de résumé synthesis, et non les formats complets hdlist), vous ne pourrez pas effectuer une recherche en entrant un
nom de fichier. Vous pourrez uniquement rechercher les paquetages par nom et par description.

Arbre des catégories. Pour faciliter leur gestion, les paquetages sont rangés en catégories (Réseau, Bureau-
tique, Jeux, Développement, Graphisme, etc. ).Ouvrez une catégorie pour afficher les paquetages correspon-
dants aux critères de sélection utilisés dans Groupe de paquetages et dans Recherche de paquetage.

Liste des paquetages. Les paquetages correspondants aux critères (de Groupe,de Catégorie et de Recherche)
s’affichent ici. Vous pouvez sélectionner les paquetages à installer, à supprimer et à mettre à jour.

Description du paquetage. affiche des informations détaillées sur le paquetage actuellement sélectionné dans
la liste des paquetages.

Note : De plus, une barre d’état située dans la partie inférieure de la fenêtre affiche des messages concernant les actions
en cours ou complétées.
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Actions sur les paquetages

1. Réduisez la liste de paquetages affichés

Utilisez la liste déroulante de groupe de paquetages, l’arbre des catégories et éventuellement l’outil de
recherche pour naviguer parmi les paquetages à installer, supprimer, ou mettre à jour.

2. Sélectionnez les paquetages

Dans la liste de paquetages, sélectionnez ceux qui doivent être installés, enlevés, ou mis à jour. Si la case
près du nom du paquetage est vide, cela veut dire qu’il peut être installé ou mis à jour, une fois sélectionné,
il sera précédé de l’icône

. Si l’icône
apparaît à la place de cette case, cela signifie que le paquetage est déjà installé, sélectionnez-le pour
le supprimer.

3. Appliquez les changements

Une fois que vous êtes satisfait de vos choix, cliquez sur Appliquer pour effectuer l’installation, la sup-
pression et la mise à jour des paquetages. Une nouvelle fenêtre apparaîtra, montrant la progression du
processus d’installation. Si vous préférez quitter en n’installant aucun logiciel, utilisez le bouton Quitter.

Gestion des dépendances

Il se peut que vous choisissiez un paquetage qui a lui même besoin d’autres paquetages (bibliothèques ou
autres nécessaires à son bon fonctionnement). Dans ce cas, Rpmdrake affichera un avertissement présentant
la liste de ces paquetages nécessaires (dépendances). Vous pouvez soit accepter, soit Annuler l’installation ou
obtenir Plus d’infos sur ce paquetage (figure 5-3).

Figure 5-3. Alerte dépendances

Dépendances alternatives. Il peut aussi arriver que vous installiez un paquetage qui nécessite des dépendan-
ces (librairies supplémentaires ou d’autres outils) et que plusieurs paquetages différents soient en mesure de
fournir une même dépendance. La liste de tous les choix susceptibles de convenir (figure 5-4) vous sera alors
proposée. Lisez les descriptions des options en cliquant sur le bouton Info... et choisissez celui qui vous semble
convenir le mieux.

Figure 5-4. Autres choix de paquetages
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Note : L’espace disque requis pour l’installation des paquetages sélectionnés peut être supérieur à la taille du paquetage
en lui-même. Ceci est dû à la nécessité d’installer ses dépendances.

5.2. Le gestionnaire de médias

Utilisez cet outil pour configurer les répertoires de média logiciels. Dans la figure 5-5 certains mé-
dias sont déjà disponibles : « Main », « Contrib », etc. Vous pouvez aussi ajouter d’autres médias
logiciel : un CD que vous avez récupéré dans un magazine contenant des RPMs, un média réseau

sur Internet, etc.

Figure 5-5. Le gestionnaire de médias logiciel

Cochez les cases sur la colonne de gauche pour marquer les répertoires

Activé?

Décochez cette boîte pour désactiver temporairement le média correspondant. Les paquetages que ce
média contient seront indisponibles jusqu’à ce que vous réactiviez ce média.

M.à.J.?

Cette boîte doit être cochée à coté du média de mise à jour, c’est-à-dire celui qui contient les paquetages
de mise à jour. Ainsi seuls les médias de mise à jour seront pris en compte lorsque vous chercherez des
mises à jour.

Boutons d’actions à droite

Supprimer

Supprime un média que vous ne souhaitez plus utiliser. Il suffit de sélectionner le média à enlever de la
liste, puis de cliquer sur ce bouton.

61



Chapitre 5. Gestion des paquetages

Éditer

Modifie les paramètres du média sélectionné, comme l’URL ou le chemin relatif vers le fichier synthesis/
hdlist (si vous ne savez pas de quoi nous parlons ici, mieux vaut ne toucher à rien et cliquer sur Annuler
au lieu de Sauvegarder).

Au cas où il vous faudrait passer par l’intermédiaire d’un mandataire (proxy) pour accéder à ce média
spécifique, cliquez sur le bouton Mandataire....

Ajouter...

Ajoute sur votre système toutes les sources officielles accessibles au public à partir de répertoires situés
sur Internet. C’est pratique, si par exemple, vous avez une connexion Internet haut débit, ou si vous
n’avez que le premier CD d’installation sous la main. Choisissez un miroir proche de votre emplacement
géographique.

Une fois que vous avez choisi votre miroir et cliqué sur OK, les informations relatives aux paquetages de
la source choisie sont téléchargées et tous les paquetages de cette source seront disponibles

Ajouter la source personnalisée

Ce bouton permet d’accéder à un nouveau dialogue, dans lequel vous entrez tous les paramètres requis
pour ajouter un nouveau média logiciel. Gardez à l’esprit que ces paramètres ainsi que les options dispo-
nibles dépendent du type de média défini.

Figure 5-6. Ajout d’une source personnalisée

Mettre à jour...

Une liste de tous les médias activés apparaît ; sélectionnez ceux que vous voulez mettre à jour et cliquez
sur Mettre à jour. Ceci est notamment utile pour les médias distants auxquels sont ajoutés de nouveaux
paquetages.

Gérer les clés...

Il est important que les nouveaux paquetages logiciel que vous installez soient authentifiés. Pour cela,
chaque paquetage peut être signé électroniquement avec une « clé », et vous pouvez autoriser/interdire
des clés pour chaque média. Sur figure 5-7, vous pouvez voir que la clé de Mandriva Linux est autorisée
pour le média « Main ». Cliquez sur Ajouter une clé... pour autoriser une autre clé pour ce média (attention,
procédez avec précaution, comme pour toutes les questions relatives à la sécurité de votre système), et
sur Supprimer une clé pour enlever la clé du média sélectionné.
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Figure 5-7. Gestion des clés d’authentification des sources

Mandataire...

(Proxy) : Si votre ordinateur est placé derrière un pare-feu, mais que vous souhaitez néanmoins utiliser les
possibilités qu’offre Rpmdrake d’accéder à des médias sur Internet (pour les mises à jour notamment), il
peut être nécessaire de passer par un serveur mandataire (ne serait-ce que pour l’accès à certains serveurs
de paquetage). Remplissez le champ Nom du serveur mandataire et éventuellement les nom d’utilisateur /
mot de passe pour se connecter au mandataire. Confirmez alors votre configuration en cliquant sur OK.

Figure 5-8. Configuration d’un mandataire pour un média distant

Parallèle...

Si vous utilisez un grand réseau d’ordinateurs, vous pouvez souhaiter installer un paquetage logiciel
sur tous les ordinateurs, en parallèle ; ce bouton ouvrira une fenêtre vous permettant de configurer le
mode « Parallèle ». Comme cela est assez compliqué, et utile pour une frange limitée d’utilisateurs, nous
n’entrerons pas plus dans les détails.

Option générales...

Ce bouton vous permet de configurer l’utilitaire de téléchargement des nouveaux paquetages, et de dé-
sactiver la vérification des paquetages par rapport aux clés de chiffrement. Ces choix sont utilisés pour
toutes les sources.

Flèches haut et bas

Ces boutons permettent de changer l’ordre dans lequel les sources sont prises en compte lorsque le systè-
me essaye d’installer un paquetage. Par défaut, la version la plus récente d’un paquetage sera toujours
installée, mais si la même version est disponible sur deux média différents, c’est celle du premier média
dans la liste qui sera installée

Astuce : Par conséquence, il préférable de mettre le média le plus rapide en premier...
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Chapitre 6. Configurer son matériel et périphériques

6.1. Configurer votre matériel

6.1.1. Détection et configuration du matériel

Le projet HardDrake a été développé pour simplifier la configuration du matériel sous GNU/Linux
en proposant une interface simple à utiliser.

6.1.1.1. Qu’est-ce que HardDrake ?

HardDrake est à la fois un service de détection matérielle, qui s’exécute au démarrage, et un outil graphique,
qui rassemble de nombreux outils inclus dans une distribution GNU/Linux. Son but est d’automatiser et de
simplifier l’installation de nouveaux matériels. HardDrake est capable de détecter la plupart des matériels exis-
tants.

HardDrake peut être utilisé pour afficher des informations et pour lancer des outils de configuration. Avec une
interface simple, vous serez capable de parcourir tous les périphériques qui composent votre système.

6.1.1.2. Utilisation

Pour lancer HardDrake, vous pouvez utiliser :

• le Centre de contrôle Mandriva Linux : cliquez sur l’icône correspondant à la catégorie Matériel puis cliquez
sur l’icône Matériel .

• un terminal : tapez harddrake2 en tant que root. Vous pouvez également entrer des paramètres ; tapez
harddrake2 -h pour en obtenir la liste.

• le bureau : allez dans le menu principal. HardDrake se trouve dans Système+Configuration+Matériel→
HardDrake.

Une fois le matériel détecté, la fenêtre principale de HardDrake apparaît (figure 6-1).

A gauche, vous pouvez voir l’arbre des périphériques montrant toutes les catégories.
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Figure 6-1. Périphérique Sélectionné

Si vous sélectionnez un périphérique, vous obtiendrez des informations utiles le concernant dans le cadre de
droite. Vous pouvez accéder à la page d’aide en choisissant Aide→Description des champs.

Selon le périphérique sélectionné, deux boutons peuvent apparaître :

• Spécifier les options du pilote courant. Ouvre une boîte de dialogue contenant tous les paramètres du
gestionnaire de périphériques. À réserver aux experts !

• Lancer l’outil de configuration. Lance l’outil de configuration Mandriva Linux associé à ce périphérique. Ce
sont les outils disponibles dans le Centre de contrôle Mandriva Linux.

Matériel Inconnu. Il existe une catégorie spéciale appelée Inconnus/Autres, qui contient tous les matériels
actuellement inconnus ou qui ne rentrent dans aucune des autres catégories (capteurs thermiques, générateurs
de nombre aléatoire, ...).

6.1.2. Problèmes et solutions

Si vous pensez avoir trouvé un bogue en rapport avec HardDrake, déclarez-le en utilisant l’outil de signalement
de bogue Mandriva Linux

Cartes son. Les périphériques ISA PnP ne sont pas testés par HardDrake. Si vous possédez une carte son ISA
PnP, lancez sndconfig ou alsaconf en ligne de commande afin de la configurer. Vous devrez sans doute
installer les paquetages suivants : sndconfig ou alsa-utils.

6.2. Contrôler la configuration graphique

Cet ensemble d’outils vous permet de configurer l’affichage graphique. Vous serez en mesure de changer le
choix de carte graphique, de résolution et de moniteur (ou d’écran). Cet outil peut être utile si vous modifiez
un composant graphique après l’installation initiale de Mandriva Linux.
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Si vous ne voyez pas l’écran de connexion graphique au démarrage : Si le serveur graphique ne peut démarrer à
cause d’une erreur de configuration, un message vous proposera de reconfigurer le serveur graphique. Vous obtiendrez
alors le même outil que celui décrit dans Contrôler tous les paramètres vidéo, page 68, mais en mode texte.

L’outil de configuration graphique est accessible par l’intermédiaire de différentes icônes dans la section Ma-
tériel du Centre de contrôle Mandriva Linux :

6.2.1. Choisir un nouveau moniteur

Cet outil permet de changer le type de moniteur que vous utilisez. Cliquez sur ce bouton et une
fenêtre apparaîtra dans laquelle seront listés plusieurs modèles de moniteurs ( Voir figure 6-2).Si
votre moniteur a été détecté automatiquement, il sera affiché en tant que moniteur Plug’n Play,
dans la section concernant son modèle.

Figure 6-2. Choisir un nouveau moniteur

Si votre moniteur n’est pas détecté automatiquement, choisissez le dans la liste. Si vous ne le trouvez pas (ou
un moniteur compatible), sélectionnez son équivalent dans la liste Générique, qui se situe en bas de la fenêtre.

6.2.2. Choisir une nouvelle résolution

Cet outil vous permettra de modifier la résolution actuelle de l’écran (800x600, 1024x768, etc.)
ainsi que le nombre de couleurs. Choisissez simplement celle que vous souhaitez utiliser.
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Figure 6-3. Changer la résolution de votre écran

Le moniteur dans la fenêtre montre à quoi ressemblera le bureau avec la configuration choisie (voir figure 6-3).
Les changements ne seront activés qu’après avoir quitté et relancé votre environnement graphique.

Moniteur et rapport de résolution. Par défaut, la liste des résolutions disponibles n’affiche que les résolutions
supportées par votre carte vidéo et votre moniteur. Il existe une entrée nommée Autres qui contient plus de
résolutions possibles, ainsi que leur rapport. Gardez à l’esprit que la plupart des moniteurs ont un rapport
horizontal sur vertical de 4:3.

6.2.3. Contrôler tous les paramètres vidéo

Si vous changez de carte vidéo après l’installation de votre système ou si vous désirez avoir le contrôle
total de votre configuration graphique, lancez cet outil en mode expert.
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Figure 6-4. Fenêtre principale de XFdrake

Les trois premiers boutons permettent de changer certains paramètres de la configuration graphique :

Carte graphique

Le bouton contient le nom de la carte actuellement configurée. Si vous souhaitez la changer, cliquez des-
sus. Selon votre carte, plusieurs serveurs peuvent être disponibles, avec ou sans accélération 3D. Vous
devrez peut-être en essayer plusieurs avant d’obtenir le meilleur résultat.

Si vous ne trouvez pas dans la liste la carte graphique que vous possédez, mais que vous connaissez le
pilote qui la supporte, sélectionnez-le dans le champ Xorg qui se trouve en bas.

Moniteur

Vous permet de changer de moniteur avec l’outil décrit dans la partie Choisir un nouveau moniteur, page
67.

Résolution

Vous permet de changer la résolution de l’écran ainsi que le nombre de couleurs avec l’outil décrit dans
la partie Choisir une nouvelle résolution, page 67.

Changer la résolution avec l’applet du bureau : Si vous utilisez KDE, vous pouvez aussi changer la résolution de l’écran à
la volée en utilisant l’applet de redimensionnement d’écran, accessible depuis le menu Système+Configuration+Matériel→
KRandRTray.

Il existe des boutons supplémentaires :

Test

Cliquez sur ce bouton pour vérifier que vos changements fonctionnent. Il est vivement recommandé de le
faire car si cela ne fonctionne pas, il sera plus difficile de récupérer un environnement graphique en bon
état. Si le test échoue, attendez simplement qu’il s’achève. Si l’échantillon du test ne vous a pas convaincu,
et que vous avez choisi Non pendant le test, vous retournerez au menu principal de XFdrake.

Si le test n’est pas possible : Selon votre carte vidéo, le test peut ne pas être possible. Vous en serez alors averti.
S’il s’avère que la configuration est mauvaise et que votre affichage est défectueux, lancez XFdrake en tant que
root pour utiliser la version texte de XFdrake.
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Options

Options de la carte graphique

En fonction de votre carte graphique, vous pouvez choisir ici d’activer ou désactiver des fonctionna-
lités spécifiques telles que l’accélération 3D ou des effets spéciaux (la translucidité).

Interface graphique lors du démarrage

Cette option vous permet de choisir si vous voulez que votre machine démarre automatiquement
en mode graphique. Évidemment, il est préférable de choisir Non si vous êtes en train d’installer un
serveur, ou si vous n’avez pas réussi à configurer l’écran correctement.

Quitter

Si vous avez modifié votre affichage d’une quelconque façon, une liste présentant la configuration actuelle
sera affichée et XFdrake vous demandera si vous voulez sauvegarder vos modifications ou non. C’est votre
dernière chance pour revenir à l’ancienne configuration. Si tout semble correct, cliquez sur Oui. Si vous
souhaitez restaurer les anciens paramètres, cliquez sur Non.

Les changements seront effectifs uniquement après que vous les ayez validés et que vous aurez relancé votre
environnement graphique.

6.3. Configuration du bureau 3D

Cette outil accessible depuis la section Matériel du Centre de contrôle Mandriva Linux, vous permet de
configurer le « bureau 3D » pour obtenir des effets visuels étonnants et transformer votre bureau plat
classique en un bureau cubique.
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Figure 6-5. Activation des effets du bureau 3D

Activer le bureau 3D

1. La première fois que vous lancez Drak3D quelques paquetages requis sont installés, puis l’interface prin-
cipale apparaît (voir figure 6-5).

2. Sélectionnez l’option Effets bureau 3D complet (compiz) pour activer le bureau 3D. Deux approches sont
possibles : AIGLX et Xgl, Drak3D sélectionne pour vous la plus appropriée en fonction de votre matériel.

3. Cliquez sur Lancer l’outil de configuration compiz pour personnaliser entièrement chaque aspect de la ges-
tion du bureau 3D, dans la nouvelle fenêtre qui apparaît, vous pouvez définir tous les paramètres à votre
goût.

À propos des bureaux : Une fois que le bureau 3D est activé, le nombre de bureaux virtuels sera réduit à un, comme
le montre le gestionnaire de bureau (KDE ou GNOME). A la place, vous disposez de viewports (les côtés du cube)
en guise de bureaux virtuels, explorez-les et amusez-vous bien!

4. Si vous êtes satisfait de vos réglages, appliquez-les en cliquant sur Ok; ils prendront effet la prochaine fois
que vous vous connecterez à votre interface graphique.

Désactiver la 3D. Sélectionnez l’option Pas d’effets bureau 3D pour désactiver complètement le bureau 3D et
revenir à votre bureau « plat ».

6.4. KeyboardDrake : changer votre type de clavier

Cet outil vous permet de définir une autre configuration de clavier, dans le cas où le clavier
que vous utilisez serait différent de celui choisi lors de l’installation.
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Figure 6-6. Choix d’une autre configuration de clavier

Sélectionnez la langue de votre clavier et son modèle dans la liste (figure 6-6). Si vous possédez un clavier mul-
timédia et qu’il se trouve dans la liste de constructeurs, il y a de bonnes chances que les touches multimédias
soient prises en charge. Sinon, choisissez le type de votre clavier dans la branche Générique. Les changements
sont effectifs immédiatement après avoir cliqué sur OK.

Note : Si vous choisissez une configuration de clavier basée sur un alphabet non latin, une bôıte de dialogue vous demande
de choisir la combinaison de touches que vous souhaitez utiliser pour passer d’une configuration à l’autre.

6.5. Changement de souris

Cet outil vous permet de paramétrer une autre souris, dans le cas où celle que vous utilisez actuelle-
ment est différente de celle choisie durant l’installation.

Note : La fonction Synaptics Touchpad est configurée automatiquement pour fonctionner avec la plupart des pavés
tactiles (touch pads) des ordinateurs portables. Il en va de même pour les tablettes Wacom®.
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Figure 6-7. Choix d’une autre souris

Les souris sont classées en arborescence par type de connexion, puis par modèle (voir figure 6-7). Sélectionnez
la souris de votre choix, puis cliquez sur OK. Les changements effectués sont pris en compte immédiatement.

Astuce : L’option N’importe quelle souris PS/2 & USB fonctionne avec la plupart des souris récentes.

6.6. Configuration d’une imprimante

Cet outil vous permet de :

• configurer une imprimante nouvellement connectée sur votre machine ;

• configurer votre système pour servir une imprimante réseau connectée à votre réseau local ;

• permettre à votre machine d’accéder aux imprimantes réseau servies par d’autres serveurs .

6.6.1. Installation automatique

Si vous branchez une imprimante sur un port USB de votre ordinateur et vous l’allumez, un dialogue s’affiche :
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Figure 6-8. Une nouvelle imprimante a été détectée

Désactiver la détection automatique. Si vous ne voulez plus que le dialogue « installation automatique »
s’affiche, cochez Ne plus installer l’imprimante automatiquement.

Puis cliquez sur Ok, tous les paquetages requis seront installés et l’imprimante configurée, vous pouvez
l’utiliser tout de suite : il n’y a aucune autre manipulation à faire !

Configuration. Il est recommandé que vous vérifiez les paramètres par défaut de l’imprimante, particulière-
ment le format du papier. Pour cela, lancez PrinterDrake depuis le Centre de contrôle Mandriva Linux et suivez
les instructions de la Reconfiguration d’une imprimante, page 82.

6.6.2. Configuration manuelle

Astuce : Si vous venez d’installer une imprimante qui n’était pas disponible quand vous avez installé Mandriva Linux
assurez-vous qu’elle est correctement connectée et sous tension avant de lancer l’outil de configuration.

Lorsque vous lancez l’outil PrinterDrake pour la première fois, il peut s’afficher dans l’un des états suivants :

6.6.2.1. Aucune imprimante n’est directement connectée à l’ordinateur

Figure 6-9. Activation de l’impression
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L’outil n’a pas détecté d’imprimante locale. Cependant, vous pouvez imprimer sur une imprimante connectée
à une machine distante, ou configurer manuellement une imprimante qui n’aurait pas été détectée en cliquant
sur Oui.

Figure 6-10. Activation des imprimantes réseau

• Sélectionnez l’option système d’impression CUPS local si vous désirez que votre machine devienne un serveur
d’impression pour une imprimante locale ou connectée à votre réseau local.

Les logiciels nécessaires seront installés, puis l’interface principale de configuration (figure 6-12) apparaîtra.
Cliquez sur le bouton Ajouter une imprimante pour installer l’imprimante réseau.

• Sélectionnez l’option Serveur distant pour utiliser des imprimantes servies par un serveur d’impression
CUPS distant. Vos applications auront immédiatement accès à toutes les imprimantes publiques gérées par
ce serveur. Vous n’aurez qu’à fournir le nom d’hôte ou l’adresse IP de ce serveur dans le champ approprié
(renseignez-vous auprès de votre administrateur système).

Ensuite, l’interface principale de configuration (figure 6-12) apparaît et les imprimantes réseau disponibles
sont affichées dans l’onglet Configurée(s) sur d’autres machines.

6.6.2.2. Nouvelle imprimante détectée

La fenêtre suivante apparaît lorsque PrinterDrake détecte une imprimante au démarrage.
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Figure 6-11. Une nouvelle imprimante est détectée

Confirmez l’installation automatique de la nouvelle imprimante. L’interface principale de configuration
s’affiche (figure 6-12). Vérifiez que les paramètres de l’imprimante conviennent à vos besoins (Reconfiguration
d’une imprimante, page 82).

6.6.2.3. Une imprimante est déjà configurée

La fenêtre principale de configuration (voir figure 6-12) apparaît. Vérifiez que les paramètres de l’imprimante
conviennent à vos besoins (Reconfiguration d’une imprimante, page 82).

6.6.3. L’interface de gestion des imprimantes

Imprimante locales et distantes. Utilisez le premier onglet de l’outil de configuration d’imprimante pour les
imprimantes locales (Configurée(s) sur cette machine), et l’autre onglet pour les imprimantes disponibles sur le
réseau local (Configurées sur d’autres machines).
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Figure 6-12. Gestion des imprimantes

Les boutons suivants vous donnent accès à toutes les tâches de maintenance disponibles :

• Ajouter une nouvelle imprimante : pour lancer l’assistant de configuration des imprimantes décrit ici dans la
L’assistant de configuration d’imprimantes, page 80.

• Par défaut : designe l’imprimante sélectionnée comme celle utilisée par défaut, lorsqu’aucune imprimante
particulière n’est sollicitée. Une croix apparaît dans la colonne Def. de cette imprimante.

• Éditer : ouvre le menu de configuration de l’imprimante (voir Reconfiguration d’une imprimante, page 82).

• Supprimer : enlève l’imprimante sélectionnée de la liste des imprimantes disponibles.

• Rafrâıchir : met à jour la liste des imprimantes , particulièrement utile pour les imprimantes réseau.

• Configuration de CUPS : par défaut, votre système est ouvert. PrinterDrake utilise toutes les imprimantes ac-
cessibles sur le réseau et partage toutes ses imprimantes locales. Cliquez sur ce bouton si vous ne souhaitez
pas imprimer sur des imprimantes du réseau, ou si vous voulez restreindre l’accès à vos propres impri-
mantes. Vous pouvez aussi y configurer l’accès à des serveurs d’impression en dehors du réseau local (voir
Configuration générale du serveur d’impression, page 77).

Note : La case à cocher du menu Options→Mode Expert donne accès à des fonctionnalités avancées (voir Mode Expert,
page 83).

6.6.4. Configuration générale du serveur d’impression

Le bouton Configurer CUPS vous permet de contrôler le comportement des imprimantes connectées sur votre
machine et au réseau.
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Figure 6-13. Configuration du serveur d’impressions CUPS

Ce dialogue vous permet de passer du mode d’impression client au mode serveur avec le bouton Serveur CUPS
distant et pas de démon CUPS local.

Ce bouton vous permet de choisir entre deux méthodes d’accès à un serveur distant.

Dans la première méthode, votre serveur doit avoir un daemon CUPS en service et à l’écoute sur le port 631
pour gérer la file d’attente d’impression et écouter les tâches d’impression en provenance des applications.
Dans ce cas, le serveur CUPS signale sa présence à l’ensemble du réseau. C’est la configuration par défaut.

Dans la seconde méthode, le daemon CUPS est toujours requis pour gérer la file d’impression et les gérer les
tâches arrivant sur le port 631, mais il ne signale pas sa présence sur le réseau. Dans ce cas, les clients n’ont
pas besoin d’exécuter le daemon CUPS, en revanche ils ont une configuration de fichiers qui contient l’adresse
IP du serveur. De cette façon, les clients savent qu’ils peuvent transmettre des tâches directement à l’adresse
IP.

Avantages Inconvénients

Méthode 1 Aucune configuration de client
requise

Fonctionne avec au moins un port
ouvert et consomme des
ressources système
supplémentaires

Méthode 2 Aucun système d’impression local.
Aucun port ouvert.

Si l’adresse IP du serveur change,
ou si les clients changent de
réseau, alors une reconfiguration
est nécessaire.

Tableau 6-1. Considérations
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6.6.4.1. Mode client

Figure 6-14. Configuration du mode client

Sélectionnez l’option Actif pour vous connecter à un autre serveur d’impression. Il ne vous reste plus qu’à
spécifier le nom ou l’adresse IP de ce serveur dans le champ au-dessous.

Si vous choisissez ce mode, votre configuration est terminée. Acceptez les options en cliquant sur le bou-
ton OK, et vous pourrez consulter la liste des imprimantes disponibles dans l’onglet Configurées sur d’autres
machines de l’interface principale (voir figure 6-12).

6.6.4.2. Mode serveur

Si vous souhaitez que votre machine puisse accéder aux imprimantes connectées localement (sur un port
parallèle ou USB), ou aux imprimantes réseau qui ne sont pas déjà prises en compte par un autre serveur,
vous devez sélectionner l’option Désactivé. Cliquez sur OK pour configurer votre serveur d’impression (voir
figure 6-13).

Plusieurs options sont alors proposées pour sécuriser et améliorer les performances de votre serveur :

Les imprimantes de cette machine sont disponibles aux autres ordinateurs

Permet à d’autres ordinateurs d’imprimer sur vos imprimantes configurées localement. Pour en restrein-
dre l’accès, cliquez sur Partage d’imprimantes sur les hôtes/réseaux (voir ci-dessous).

Trouver automatiquement des imprimantes disponibles sur des machines distantes

Indique à votre serveur d’impression de rendre disponible toutes les autres imprimantes trouvées sur
les autres serveurs du réseau local, comme si elles étaient directement connectées à votre serveur
d’impression. De cette façon, les utilisateurs de votre serveur d’impression pourront imprimer sur toutes
les imprimantes que le serveur « voit », qu’elles soient locales ou distantes. Si les imprimantes distantes
que vous souhaitez utiliser sont servies par un serveur ne faisant pas partie de votre réseau local, vous
pouvez spécifier manuellement son adresse grâce au bouton Serveurs CUPS additionnels (voir ci-dessous).

Partage d’imprimantes sur les hôtes/réseaux

Permet de spécifier quels réseaux ont accès aux imprimantes locales.

Serveurs CUPS additionnels

Permet de spécifier un ou plusieurs serveurs CUPS sur lesquels vous pouvez vous connecter et accéder
aux imprimantes. Spécifiez l’adresse IP et le port du serveur CUPS dans le dialogue qui apparaît.
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Mode d’impression du texte japonais

Remplace le filtre texte original par un autre plus approprié aux textes en japonais, mais avec moins de
fonctionnalités. Utilisez cette option si vous devez imprimez des fichiers texte en japonais.

6.6.5. L’assistant de configuration d’imprimantes

Cliquez sur le bouton Ajouter une imprimante et l’assistant de configuration apparaît.

6.6.5.1. Détection d’une imprimante ou spécification du chemin d’accès

La première étape permet soit de spécifier un chemin d’accès à une imprimante réseau, soit d’activer la détec-
tion automatique des imprimantes locales, réseau, ou servies par un serveur SMB (Windows®).

Figure 6-15. Type de connexion de l’imprimante

Spécification du chemin. Si vous connaissez tous les paramètres requis pour accéder à une imprimante ré-
seau particulière, sélectionnez Entrer le nom de l’hôte/l’adresse IP de l’imprimante réseau. Ensuite, les étapes de
configuration sont similaires à celles de la procédure de détection automatique.

6.6.5.2. Choix de l’imprimante

Figure 6-16. Liste des imprimantes détectées

1. Choisissez l’imprimante à configurer
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Choisissez l’imprimante que vous voulez ajouter depuis la liste. Si celle détectée n’est pas la bonne, cochez
la case Sélectionner manuellement le modèle et poursuivez vers l’étape de sélection du modèle d’imprimante.
Si la détection automatique échoue, décochez toutes les cases, cliquez sur Suivant et suivez les instructions.

2. Spécifier le pilote manuellement

PrinterDrake affiche le nom du modèle de votre imprimante. Choisissez Sélectionner le modèle manuellement
si le modèle proposé est incorrect. Sélectionnez votre imprimante ou une autre compatible (voir Choix de
l’imprimante, page 80) si la vôtre n’apparaît pas dans la liste.

3. Pilote fourni par le fabriquant

Si vous voulez installer le pilote fourni par le fabriquant de votre imprimante, cliquez sur le bouton Installer
un fichier PPD fourni par le fabriquant et sélectionnez le support contenant le fichier PPD et naviguez jusqu’à
ce fichier. Acceptez les choix proposés dans les dialogues suivants pour utiliser le fichier PPD choisi.

4. Imprimante multifonction HP

Si vous possédez une imprimante multifonction telle que celles de HP ou Sony, une fenêtre informative
apparaît et vous renseigne au sujet de votre scanner et des logiciels associés (Installation et partage du
scanner, page 83). Des paquetages supplémentaires sont aussi installés.

Imprimante virtuelle Fax. Si votre imprimante possède également une fonction fax, vous avez la possibi-
lité de créer une imprimante fax virtuelle qui mettra en attente les documents imprimés pour qu’ils soient
télécopiés ultérieurement.

5. Étape de configuration optionnelle

Si votre imprimante possède des accessoires en option (finishers, bac d’alimentation papier supplémen-
taire, etc.), précisez lesquels sont actuellement installés.

6.6.5.3. Test d’impression

Plusieurs pages de test sont disponibles (figure 6-17). Il est préférable d’imprimer au moins une page de
test tout de suite afin de modifier éventuellement les paramètres erronés. L’impression de cette page de test
commence presque immédiatement.

Figure 6-17. Test de l’impression
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6.6.5.4. C’est fini

Si l’impression s’est mal déroulée, répondez par Non pour revenir au menu de configuration de l’imprimante
(figure 6-18) et modifier ses paramètres. Voir Reconfiguration d’une imprimante, page 82.

Votre imprimante apparaît désormais dans la liste d’imprimantes configurées de la fenêtre principale (figure
6-12).

6.6.6. Reconfiguration d’une imprimante

En faisant un double-clic sur le nom d’une imprimante ou en cliquant sur le bouton Éditer, un menu appa-
raît, permettant de modifier la configuration de l’imprimante (figure 6-18). Vous pouvez modifier le nom de
l’imprimante, ses options, etc.

Figure 6-18. Modification d’une imprimante

Voici les options les plus pratiques :

• Nom, description, emplacement. Si vous avez plusieurs imprimantes, il est préférable de leur donner un nom
explicite, une description pertinente, et d’en indiquer l’emplacement, pour que les usagers ne se retrouvent
pas à chercher désespérément leurs impressions à tous les étages.

• Options de l’imprimante. Affiche les différentes options disponibles pour cette imprimante (format du papier,
mode d’impression, etc.), pour en définir les valeurs par défaut.

• Rendre l’imprimante invisible pour les autres ordinateurs. Les imprimantes sont normalement rendues accessi-
bles aux autres ordinateurs du réseau local. En utilisant cette option, vous désactivez ce comportement pour
l’imprimante sélectionnée.

• Désactiver l’imprimante. Utilisez cette option pour supprimer une imprimante de la liste des imprimantes dis-
ponibles des utilisateurs système. Vous pourriez avoir besoin de désactiver temporairement une impriman-
te en maintenance pour éviter son utilisation pendant cette période. Lorsqu’une imprimante est désactivée,
cette option devient Activer l’imprimante.

• Savoir comment utiliser cette imprimante. Affiche des informations sur la manière d’utiliser l’imprimante.
Dans le cas d’une imprimante multifonction HP ou autre, l’acquisition ou l’accès aux cartes mémoire est
aussi documenté.

• Supprimer l’imprimante. Si vous souhaitez supprimer une imprimante de votre système.

Sélectionnez une option dans la fenêtre et cliquez sur le bouton Faire.
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6.6.7. Contrôler les installations automatiques

Cliquez sur le menu Options→Configurer l’administration automatique pour afficher le formulaire d’options
d’installation automatique.

Figure 6-19. Définir les options d’installation automatique

C’est ici que vous pouvez définir si les nouvelles imprimantes doivent être automatiquement détectée, confi-
gurée, etc.

6.6.8. Mode Expert

Le mode expert active des fonctionnalités supplémentaires :

Assistant d’installation plus technique. L’assistant d’installation affiche des informations plus techniques
et vous permet de configurer le nom de l’imprimante ainsi que d’autres options directement à partir de
l’assistant.

Choix d’un pilote différent du pilote par défaut. Plusieurs pilotes sont généralement disponibles pour
une même imprimante. En mode expert, un troisième niveau apparaît dans l’arborescence de sélection de
l’imprimante (Choix de l’imprimante, page 80) permettant de modifier le pilote associé à une imprimante.

Pas de configuration automatique. Si PrinterDrake est en mode expert, il ne configure pas automatiquement
les nouvelles imprimantes locales au démarrage. Utilisez le bouton Ajouter une imprimante pour ce faire. Tou-
tefois, vous pouvez choisir le mode Configure Auto Administration depuis le menu Options pour annuler ce
comportement.

Correction automatique de la configuration du serveur CUPS. Cette nouvelle option apparaît dans la fenêtre
de configuration du serveur CUPS (figure 6-13. Elle est activée par défaut. Laissez la souris sur le nom de
l’option pour avoir plus d’information sur sa fonction.

6.7. Installation et partage du scanner

L’assistant ScannerDrake vous aide à installer votre scanner. Assurez-vous que votre scanner
est sous-tension et lancez ScannerDrake en cliquant sur Scanners dans la catégorie Matériel du
Centre de contrôle Mandriva Linux.
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Astuce : Notez que tous les scanners ne sont pas supportés sous GNU/Linux. Avant d’acheter un nouveau périphérique,
vérifiez la Base de données HCL de Mandriva (http://hcl.mandriva.com) (en anglais) et le site Internet de SANE
(http://www.sane-project.org/) pour connâıtre les problèmes de compatibilité.

6.7.1. Interface principale et installation du scanner

Le programme tente de détecter le fabriquant et le modèle de votre scanner. S’il trouve le scanner, des informa-
tions le concernant sont affichées dans la partie supérieure de la fenêtre principale de l’assistant. Cette fenêtre
présente aussi quelques boutons d’action. (figure 6-20).

Figure 6-20. Installation de votre scanner

Rechercher des nouveaux scanners

Cliquez sur ce bouton pour détecter automatiquement un nouveau scanner que vous aurez préalablement
branché.

Ajouter manuellement un scanner

Utilisez ce bouton si la détection automatique échoue et recherchez le modèle spécifique de scanner que
vous possédez en parcourant la liste des modèles disponibles.

Figure 6-21. Arborescence de tous les modèles de scanners connus
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Choisissez le port adéquat. Après avoir choisi le modèle approprié, vous pouvez laisser les paramètres par
défaut de l’option Détecter automatiquement les ports disponibles à moins que votre scanner ne soit équipé d’un
port parallèle, auquel cas vous devez choisir /dev/parport0 dans la liste déroulante.

Imprimantes multifonction HP

Notez que les imprimantes multifonction d’HP, telles que les modèles OfficeJet et PSC doivent être configurées
à l’aide de PrinterDrake. Reportez-vous à Configuration d’une imprimante, page 73. La fonction scanner des
imprimantes multifonction autres qu’HP peut être configurée avec ScannerDrake, en tant que scanner autonome.

6.7.2. Partage de votre scanner

ScannerDrake permet aux utilisateurs connectés via un LAN de partager le même scanner.

Figure 6-22. Partage de scanner à l’intérieur d’un LAN

Partagez votre propre scanner

1. Cochez la case Les scanners de cette machine sont utilisables par les autres ordinateurs.

2. Cliquez sur le bouton Partage de scanners pour les hôtes puis sur Ajouter les hôtes pour spécifier quels hôtes
seront autorisés à accéder à votre scanner.

Utiliser le scanner des autres

1. Cochez la case Utiliser des scanners sur des ordinateurs distants.

2. Cliquez sur le bouton Utilisez les scanners sur les hôtes puis sur Ajouter les hôtes pour spécifier quels hôtes
servent le scanner que vous souhaitez utiliser.
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6.8. Paramétrage de votre UPS

Cet outil configurera pour vous le service NUT (Network UPS Tool). Ce service vérifie l’UPS connecté
à votre machine et l’éteint automatiquement quand sa batterie est presque épuisée.

Installation Automatique. Ouvrez le Centre de contrôle Mandriva Linux, puis la catégorie Matériel et cliquez
sur Configurer un onduleur (UPS) pour la surveillance du courant électrique pour lancer DrakUPS. Cochez l’option
Connecté via un port série ou un câble USB pour laisser DrakUPS détecter automatiquement votre UPS.

Configuration manuelle (Port série)

1. Sélectionnez l’option Configuration manuelle.

2. Sélectionnez votre UPS parmi la liste de fabricants et de modèles.

3. Puis, assignez-lui un Nom, un Pilote, et un Port1.

Si tout s’est bien passé, votre UPS devrait maintenant être configuré et prêt à vous aider à éviter les mauvaises
surprises dues aux coupures de courant.

1. Les champs Nom et Pilote devraient être automatiquement remplis. Bien sûr, vous pouvez changer son nom, mais
nous vous recommandons de conserver le nom du pilote.
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7.1. Gestion des connexions réseau et Internet

Astuce : Avant de vous connecter à Internet, il est conseillé de configurer un pare-feu sur votre machine, pour éviter
de mauvaises surprises comme des intrusions. Vous pouvez mettre en place un pare-feu simple et efficace en utilisant
DrakFirewall (voir la DrakFirewall : configuration d’un pare-feu élémentaire, page 111 pour plus de renseignements).

L’ensemble d’outils drakconnect facilite la configuration et la maintenance de vos accès réseau, que ce soit sur
Internet ou un réseau local. Pour lancer drakconnect, ouvrez le Centre de contrôle Mandriva Linux et cliquez
sur Réseau & Internet. À partir de là, plusieurs utilitaires vous permettent de configurer et de superviser les
connexions réseau. L’interface principale est reproduite dans la figure 7-1.

Figure 7-1. Outils DrakConnect

7.1.1. Nouvelle connexion

drakconnect peut gérer plusieurs sortes de connexions réseau et Internet. La première étape
consiste à choisir le type de connexion que vous souhaitez utiliser. Assurez-vous que vous avez
sous la main toutes les informations fournies par votre fournisseur d’accès à Internet ou votre
administrateur réseau.

Note : Une fois la connexion configurée, elle peut être modifiée en utilisant l’interface de gestion des connexions. (voir
Reconfiguration d’une interface, page 91).

7.1.1.1. Configuration d’une connexion Ethernet

1. Sélectionnez la connexion de type Ethernet

Vos interfaces réseau sont détectées automatiquement : si vous en possédez plus d’une, vous devez sélec-
tionner celle que vous souhaitez configurer. Vous pouvez aussi charger un pilote de périphérique (driver)
manuellement.
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2. Configuration automatique ou statique

Vous devez maintenant spécifier si les paramètres réseau seront attribués automatiquement (Attribution
automatique de l’adresse IP (BOOTP/DHCP)) ou non (Configuration manuelle) : remplissez les champs sui-
vants avec les informations fournies par votre FAI ou votre administrateur réseau.

3. Contrôle de la connexion

Autoriser les utilisateurs à gérer la connexion

Si vous souhaitez que les utilisateurs puissent activer ou fermer la connexion, sans avoir besoin de
fournir le mot de passe root (voir Surveillance des connexions, page 91) cochez cette case.

Lancer la connexion au démarrage

Décochez cette case si vous voulez que la connexion soit activée à la demande uniquement.

L’applet réseau : Une applet apparâıt sur le tableau de bord indiquant que la connexion est active

ou inactive

. Faites un clic droit pour accéder à un menu depuis lequel vous pourrez contrôler l’état de votre connexion ainsi
que d’autres paramètres.

7.1.1.2. Connexion sans fil

Cet outil permet de configurer les cartes réseau sans fil (WiFi) PCMCIA ou PCI.

1. Choisissez votre carte WiFi

Si votre carte Wifi n’est pas dans la liste, choisissez l’option Utiliser un pilote Windows . A l’étape suivante,
vous devez sélectionner le pilote à partir du CD du fabricant de la carte.

2. Choisissez le réseau

Une liste des réseaux qui ont été détectés apparaît. Sélectionnez le vôtre, sinon l’option non-listé?.

3. Paramétrage de la connexion sans fil

Mode de fonctionnement

Le mode dans lequel la carte fonctionnera par rapport aux autres équipements Wifi du réseau; Le
plus courant est Géré pour se connecter simplement à un point d’accès existant.

Nom de réseau (ESSID)

Le nom du réseau auquel vous souhaitez vous connecter. Demandez à votre administrateur réseau.

Mode de chiffrement

Ceci dépend des paramètres du réseau, demandez-les à votre administrateur réseau.

Clé de chiffrement

Ceci dépend aussi des paramètres du réseau, demandez à votre administrateur la clé utilisée pour le
réseau choisi.

4. Configuration du réseau

Ceci est similaire à la configuration d’un réseau Ethernet classique : Configuration d’une connexion Ethernet,
page 87.

5. Contrôle de la connexion

Cochez la case Autoriser l’itinérance si vous souhaitez que la connexion passe automatiquement d’un point
d’accès à l’autre, en fonction de la force du signal. Ceci est particulièrement utile lorsque vous êtes en
déplacement avec votre portable.
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Gestion des connexions. Consultez Gestion des connexions sans sans-fil (Itinérance), page 94 pour apprendre
comment configurer et gérer plusieurs réseaux sans-fil.

7.1.1.3. Connexion RNIS/ISDN

Sélectionnez les bons paramètres dans toutes les étapes concernant votre zone géographique et votre fournis-
seur.

La dernière étape propose de vous permettre de gérer la connexion à l’aide de l’applet réseau, ce qui peut être
utile si vous n’avez besoin de la connexion que de temps en temps.

7.1.1.4. Connexion par modem (POTS)

1. Une liste des modems détectés est affichée. Si celui que vous désirez configurer n’a pas été détecté auto-
matiquement, cochez la case Choix manuel. Ensuite, choisissez le port auquel le modem est connecté. Les
paquetages requis seront installés.

2. Une liste de pays/FAI apparaît. Si votre fournisseur d’accès y est affiché, sélectionnez-le et passez à l’étape
suivante : certains paramètres (nom de la connexion, numéro de téléphone et l’authentification) seront
automatiquement configurés. Dans le cas contraire, choisissez l’option Non listé - éditer manuellement.

3. Vérifiez les paramètres et entrez les paramètres manquants, qui vous ont été fournis par votre FAI.

Figure 7-2. Saisie des paramètres de la connexion modem classique

La plupart des paramètres sont évidents, à l’exception du type d’authentification. La liste déroulante Au-
thentification donne accès au protocole supporté par votre fournisseur : Basée sur un script (une ancienne
méthode basée sur une communication entre votre système et le FAI), Manuelle par terminal (une fenêtre
de terminal s’affiche de façon à pouvoir se connecter de manière interactive), PAP, CHAP, ou PAP/CHAP
(protocoles d’échange d’information d’authentification, CHAP est préférable car plus sûr, PAP/CHAP
choisira automatiquement le protocole approprié).

4. Viennent alors les paramètres IP, DNS et passerelle. La plupart des fournisseurs d’accès permettent de
configurer cela automatiquement, il suffit donc de cocher l’option Automatique.

5. Contrôle de la connexion

Autoriser les utilisateurs à gérer la connexion

Vous devez alors indiquer si vous souhaitez que les utilisateurs puissent démarrer une connexion. Ils
pourront alors le faire sans avoir besoin du mot de passe root.
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Lancer la connexion au démarrage

Il est probablement plus sûr et moins cher de répondre Non.

6. Finalement, il es tproposé de tester la connexion. Nous vous recommandons de le faire pour vous assurer
que tous les paramètres sont corrects. Vous pouvez maintenant contrôler l’état de votre connexion Internet
en utilisant l’applet réseau. Il est aussi possible d’utiliser le contrôleur de connexion Internet par accès à
distance (kppp) en choisissant : Internet+Accès distant→K PPPà partir du menu principal.

7.1.1.5. Connexion DVB

Ce type de connexion est utilisé pour les liaisons par satellite.

1. Choisissez la carte à configurer, puis fournissez les paramètres de l’adaptateur.

2. La configuration réseau est alors similaire à la connexion de type réseau local (voir la Configuration d’une
connexion Ethernet, page 87).

7.1.1.6. GPRS/Edge/3G

Ce type de connexion gère les connexion à Internet par téléphone cellulaire, accessibles par une carte PCM-
CIA. La technologie Troisième Génération (3G), ainsi que d’autres plus anciennes (GPRS/Edge) sont prises en
charge. La prise de la norme plus récente HSDPA est aussi disponible.

7.1.2. Réglages Internet

Figure 7-3. Configuration de l’accès à Internet

Cette interface permet de spécifier les paramètres d’accès à Internet dans le cas où ils devraient être ajustés
après la configuration initiale. Ces paramètres sont appliqués au système dans son entier et sont donc partagés
par toutes les interfaces. Si nécessaire, l’adresse de la passerelle devra être modifiée comme il est expliqué dans
la Reconfiguration d’une interface, page 91.
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7.1.3. Reconfiguration d’une interface

Figure 7-4. Gestion des connexions réseau

Cet outil permet de modifier les paramètres propres à chaque interface (Nouvelle connexion, page
87). Utilisez la liste déroulante pour choisir l’interface à reconfigurer. Les onglets permettent alors
de changer les paramètres et options propres à chaque interface.
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7.1.4. Surveillance des connexions

Figure 7-5. Surveillance des connexions réseau en temps réel

Cet écran affiche l’activité des interfaces réseau. Il est possible de personnaliser les options du
graphique (voir figure 7-5). Il peut aussi être utilisé pour modifier l’état d’une connexion réseau,
en l’activant ou la désactivant (bouton en bas à gauche).

Note : L’interface de surveillance du réseau peut être activée par les utilisateurs avec l’applet réseau, pour visualiser le
trafic.

7.1.5. Suppression d’une connexion

Cet outil propose simplement de supprimer les paramètres de configuration d’une interface. Il
suffit de sélectionner l’interface à supprimer dans la liste déroulante.

Avertissement

Il ne sera pas demandé de confirmation pour la suppression d’une interface. Une fois l’interface sélectionnée, une
seule pression sur le bouton Suivant suffit à la supprimer.

7.1.6. Paramètres de la passerelle (Proxy)

Si votre connexion Internet doit (ou peut) passer par un proxy, cet outil permet de spécifier le nom
d’hôte ou l’adresse IP des passerelles pour les protocoles FTP et HTTP que votre ordinateur doit
utiliser. Remplissez les champs puis cliquez sur OK.

Ce qu’est un proxy. Un serveur mandataire, ou passerelle (en anglais proxy, connu également sous le nom de
« serveur de proximité ») va chercher des informations sur Internet à votre place. La plupart des serveurs man-
dataires conservent une copie locale des pages Web le plus souvent demandées. On appelle de tels serveurs
mandataires des « serveurs cache » et ils permettent de meilleures performances. Dans certaines entreprises et
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administrations, vous ne pouvez pas accéder directement à Internet, mais vous devez passer par un serveur
mandataire. Le pare-feu de l’entreprise ou de l’administration ne permet d’accéder directement à Internet
qu’au serveur mandataire, en général pour des raisons de sécurité.

7.2. Activation et gestion des profils réseau

Le système de profils du Centre de contrôle Mandriva Linux vous permet de conserver différents types de
configurations sur votre machine, en fonction par exemple, de différents lieux. C’est particulièrement utile
pour les ordinateurs portables qui changent sans cesse de configuration entre la maison, le bureau, le café, etc.
Les paramètres qui peuvent changer d’un profil à l’autre sont :

La configuration du réseau

Activer différentes interfaces, avec différentes configurations, pour le réseau sans-fil par exemple.

La configuration des services

Cela vous permet d’activer différents services d’un profil à l’autre, par exemple, un pare-feu à votre do-
micile et aucun pare-feu à votre bureau (voir Configuration des services au démarrage, page 97).

7.2.1. Gestion des profils

Lorsque vous créez un nouveau profil, il est basé sur le profil actif. Toutes les modifications sont automatique-
ment enregistrées dans le profil actif. Un simple menu (Profils) vous permet de les gérer.

Figure 7-6. L’interface de profils du centre de contrôle

Activer

Active le profil sélectionné.

Dupliquer

Crée un nouveau profil basé sur les paramètres du profil actif. Une boîte de dialogue apparaît pour de-
mander le nom du nouveau profil. N’oubliez pas d’activer ce profil après l’avoir créé si vous souhaitez le
configurer.
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Supprimer

Supprime le profil sélectionné, sans afficher d’autre message. Notez qu’un message d’avertissement ap-
paraît lorsque vous tentez de supprimer le profil actif, parce qu’il ne peut pas être supprimé lorsqu’il est
utilisé.

Le profil default. C’est ce profil qui est utilisé au démarrage. Il ne peut être pas supprimé.

Exemple : Créer un nouveau profil pour vous connecter de votre domicile avec un modem RTC. Vous rentrez
chez vous avec votre ordinateur portable flambant neuf que votre administrateur système a configuré pour
que vous puissiez vous connecter au réseau de votre entreprise. Vous souhaitez à présent pouvoir configurer
le réseau pour accéder à Internet de votre domicile avec un modem RTC.

1. Créez un nouveau profil appelé par exemple, « Home ».

2. Passez à celui-ci.

3. Reconfigurez votre réseau pour que le modem (au lieu de la carte réseau) soit utilisé pour accéder à
Internet (voir Gestion des connexions réseau et Internet, page 87).

4. Connectez-vous à Internet.

5. Quand vous retournez au bureau, repassez au profil « default ».

7.3. Gestion des connexions sans sans-fil (Itinérance)

Cet outil affiche les réseaux sans-fil actuellement disponibles, vous permet de passer d’un ré-
seau à l’autre et de modifier leur configuration. Si vous n’avez pas encore configuré votre in-
terface sans-fil, reportez-vous à Connexion sans fil, page 88 pour plus d’information. La figure
7-7 montre l’interface de DrakRoam : une liste des réseaux disponibles avec leurs statuts, et des

boutons d’action au-dessous.

Astuce :

Vous pouvez aussi faire un clic droit sur l’icône de puissance du signal dans le panneau et choisir Gérer
les réseaux sans fil, puis taper le mot de passe root pour accéder à l’outil.
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Figure 7-7. Interface de DrakRoam

7.3.1. Changement de réseau

Pour changer de réseau, sélectionnez-en un dans la liste, puis cliquez sur Connecter. Si le réseau est public,
vous serez immédiatement connecté. Si le réseau est privé, un dialogue tel que celui de la figure 7-8 vous
demandera les paramètres de configuration. Entrez les paramètres requis (en particulier la clé de chiffrement)
et cliquez sur Ok. Les réglages prennent effet immédiatement.

7.3.2. Configuration d’une connexion sans-fil

Si vous devez changer les paramètres du réseau, il vous suffit de sélectionner le réseau dans la liste, puis de
cliquer sur le bouton Configurer. Voir figure 7-8 pour un exemple de connexion sans fil sécurisée.

Figure 7-8. Modification des paramètres du réseau sans-fil
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Faites vos changements et cliquez sur Ok, les changements prennent effet immédiatement.
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8.1. Configuration des services au démarrage

Au démarrage, plusieurs services (programmes exécutés en tâche de fond pour réaliser de
nombreuses tâches) sont lancés. Cet outil permet à l’administrateur de contrôler ces services.
Consultez le chapitre du Manuel de Référence sur Les fichiers de démarrage : init sysv pour obtenir
plus d’information..

Figure 8-1. Choix des services disponibles au démarrage

Pour chaque service, voici la liste des éléments énumérés :

• Nom du service.

• État actuel : soit actif, soit arrêté.

• Information : en cliquant sur ce bouton, vous obtiendrez une description de ce service.

• Au démarrage : cochez cette case si vous souhaitez que ce service soit disponible lors du démarrage. 1 Si
le service choisi est un service xinetd, l’option Démarré si nécessaire sera affichée. En cochant cette case, le
service sera géré par xinetd. Vous devrez alors vous assurer que ce dernier est lui-même activé.

• Démarrer : démarre immédiatement un service, ou le relance (arrêt et démarrage) s’il était déjà activé.

• Arrêter : arrête immédiatement le service.

Quand vous cliquez sur le bouton Démarrer ou Arrêter, une infobulle vous indique l’état du service.

1. En général dans lesrunlevels niveaux d’exécution (runlevels) 3 et 5.
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8.2. Gestion des polices de caractères avec DrakFont

Cet outil vous permet de contrôler les différents styles, les familles et tailles de police de carac-
tères disponibles sur votre système. L’administrateur peut également y installer de nouvelles
polices.

La fenêtre principale (figure 8-2) donne un aperçu visuel de la configuration de police sélectionnée.

Figure 8-2. La fenêtre principale de DrakFont

drakfont est constitué de plusieurs écrans accessibles grâce aux boutons situés en bas.

Obtenir les polices Windows

Ce bouton ajoute automatiquement les polices trouvées sur les partitions Windows® de votre disque dur,
si elles existent.

Options

Vous permet de spécifier quelles applications ou quels périphériques (comme les imprimantes) utiliseront
les polices de caractères. Sélectionnez les polices qui seront utilisées et cliquez sur le bouton OK.

Désinstaller

Permet de supprimer des polices installées, de façon à gagner de la place sur le disque dur par exemple.
Utilisez ce bouton avec précaution, car il peut y avoir des répercussions fâcheuses sur vos applications.
Ne désinstallez pas des polices que vous n’avez pas installées vous-même.

Ce bouton supprime toutes les polices trouvées dans un répertoire donné. Notez que les polices ajoutées
manuellement avec drakfont se trouvent dans /usr/share/fonts/drakfont/
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Importer

Permet d’ajouter des polices récupérées hors de la distribution Mandriva Linux, sur un CD de polices que
vous avez acheté ou sur Internet, par exemple. Les formats de polices supportés sont ttf, pfa, pfb, pcf,
pfm, gsf. Si vous cliquez sur Ajouter, un dialogue standard apparaît, vous permettant de choisir le fichier
de police à importer. Une fois que vous avez choisi toutes les polices que vous voulez importer, cliquez
sur le bouton Installer les polices.

Sélection de plusieurs polices : Pour sélectionner plusieurs polices, appuyez sur CTRL maintenez cette touche
enfoncée tout en sélectionnant les polices que vous voulez installer et cliquez sur OK : elles seront ajoutées dans la
fenêtre Importer des polices. Puis, cliquez sur le bouton Installer les polices.

Note : Quand vous ajoutez ou supprimez des polices, les modifications peuvent ne pas être visibles immédiatement dans
la liste de polices. Fermez et relancez drakfont pour vous assurer que vos modifications ont bien été prises en compte.

8.3. Réglage de la date et de l’heure de votre ordinateur

Ce petit outil permet de configurer la date et l’heure interne de votre système.

Figure 8-3. Changement de la date et de l’heure

Vous pouvez changer la date à gauche, et l’heure à droite :

1. Date

Pour changer l’année, cliquez sur les petites flèches de chaque côté de l’année ; faites de même pour
changer le mois. Cela met à jour le calendrier du mois en dessous, où vous pourrez cliquer sur la date du
jour pour la mettre en surbrillance.
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2. Fuseau Horaire

Il est recommandé de vérifier que la configuration du fuseau horaire est conforme à votre emplacement
géographique. Cliquez sur le bouton Changer le fuseau horaire et sélectionnez l’emplacement correct dans
la liste.

Lorsque vous avez choisi le fuseau horaire, un dialogue apparaît vous demandant si votre horloge système
est réglée sur Greenwich (GMT). Répondez Oui si GNU/Linux est le seul système installé sur cette machine,
Non dans le cas contraire.

3. Heure

Pour changer l’heure, vous pouvez soit bouger les aiguilles des heures, minutes et secondes à la souris;
soit modifier les chiffres correspondants en dessous.

4. Synchronisation automatique de l’horloge

Si vous possédez une connexion Internet permanente et que vous désirez que votre système synchronise
son horloge interne avec des serveurs de synchronisation horaire en réseau, cochez la case Activer NTP et
choisissez un Serveur, de préférence près de chez vous, dans la liste déroulante. Si vous connaissez le nom
ou l’adresse IP d’un serveur local, vous pouvez aussi l’entrer manuellement.

Lorsque vous avez terminé, cliquez sur OK pour appliquer vos changements, ou Annuler pour fermer l’outil,
et renoncer aux changements. Si vous souhaitez revenir à la configuration en vigueur sur le système, cliquez
sur Réinitialiser.

8.4. Surveillance de l’état et de l’activité du système

Cet outil permet de rechercher des lignes particulières dans un ou plusieurs fichiers journaux (log),
facilitant ainsi la recherche d’incidents particuliers ou de problèmes de sécurité.

8.4.1. Consultation des journaux du système

Figure 8-4. Consultation et recherches dans les fichiers journaux
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Pour faire une recherche parmi les fichiers journaux, voici les étapes à suivre: :

1. Termes à rechercher

Vous devez choisir entre rechercher les lignes qui ne contiennent qu’un mot particulier en remplissant le
champ Contenant ; et/ou celles qui ne contiennent pas tel mot en remplissant le champ mais ne contenant
pas.

2. Fichier journal

Vous devez ensuite choisir le fichier sur lequel vous souhaitez lancer la recherche, dans la zone Choisir le
fichier ; il suffit de cocher la case correspondante.

Note : Le journal Actions des Outils Mandriva Linux est écrit par les outils de configuration Mandriva Linux, comme
ceux qui font partie du Centre de contrôle Mandriva Linux. Chaque fois que ces outils modifient la configuration du
système, ils le signalent dans ce journal.

3. Date de l’événement

Vous pouvez éventuellement restreindre la recherche à un jour particulier. Dans ce cas, cochez la case Ne
montrer que pour ce jour,puis choisissez le jour désiré dans le calendrier sur la droite.

4. Recherche

Quand tout est configuré, cliquez sur le bouton chercher. Le résultat apparaîtra dans la liste contenu du
fichier, en bas.

En cliquant sur le bouton Valider, vous pourrez enregistrer les résultats de votre recherche dans un fichier texte
(*.txt).

8.5. Gestion des utilisateurs et des groupes

UserDrake est un utilitaire évolué qui permet à l’administrateur système d’ajouter et de supprimer facilement
des utilisateurs, de les assigner à des groupes et de manipuler ces groupes de la même manière.

Note : Dans cette section, nous nous concentrons uniquement sur la gestion des utilisateurs ; la manipulation des groupes
est très similaire.

8.5.1. L’interface

Au lancement, UserDrake affichera la fenêtre principale (figure 8-5), qui liste les utilisateurs qui ont été créés
sur le système. Vous pouvez lier des utilisateurs à des groupes en activant l’onglet Groupes à droite de celui
des Utilisateurs.
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Figure 8-5. La liste des utilisateurs dans UserDrake

Tous les changements ont un effet immédiat sur la base d’utilisateurs locaux. Si la liste des utilisateurs est mo-
difiée en dehors de UserDrake, vous pouvez relire la nouvelle configuration en cliquant sur le bouton Rafrâıchir.

Note : Si vous faites des modifications concernant un utilisateur connecté, ces changements ne seront effectifs qu’à la
prochaine connexion de celui-ci.

Les actions disponibles sont :

Ajouter utilisateur

Ajoute un nouvel utilisateur au système. Nous détaillons la procédure dans Ajout d’un nouvel utilisateur,
page 102

Ajouter groupe

Ajoute un nouveau groupe d’utilisateurs au système.

Éditer

Permet de modifier les paramètres de l’utilisateur ou du groupe sélectionné. Nous détaillons les paramè-
tres utilisateur dans Ajout d’un nouvel utilisateur, page 102. Dans le cas d’un groupe, vous pourrez ajouter
ou supprimer des utilisateurs appartenant à ce groupe.

Supprimer

Supprime du système l’utilisateur ou le groupe sélectionné. Un message de confirmation s’affiche et dans
le cas d’un utilisateur, vous pourrez choisir de supprimer aussi son répertoire personnel /home ainsi que
sa boîte aux lettres.

8.5.2. Ajout d’un nouvel utilisateur

Lors de l’installation, nous avons créé l’utilisateur standard Reine Pingusa, et maintenant nous voulons créer
un nouvel utilisateur, Pierre Pingus. Puis, nous désirons les associer au groupe fileshare (partage de fi-
chiers) afin qu’ils puissent partager des dossiers sur le réseau avec d’autres utilisateurs .

Cliquez sur le bouton Ajouter utilisateur pour ajouter un nouvel utilisateur (figure 8-6). Le seul champ obliga-
toire est Utilisateur même si nous vous recommandons fortement d’assigner un mot de passe à cet utilisateur :
remplissez les champs Mot de passe et Confirmation du mot de passe. Vous pouvez aussi ajouter un commentaire
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dans le champ Nom complet. Généralement, c’est le nom complet de l’utilisateur, mais vous pouvez entrer ce
que vous voulez.

Figure 8-6. Ajout d’un nouvel utilisateur au système

Notre liste contient maintenant deux utilisateurs. Sélectionnez l’un des deux par un simple clic de souris, puis
cliquez sur le bouton Éditer. La fenêtre d’attributs figure 8-7 s’affichera. Elle vous permet de modifier la plupart
des paramètres de l’utilisateur.

Figure 8-7. Affectation des utilisateurs à un groupe

La fenêtre est composée des onglets suivants :

Données utilisateur

Permet de modifier les informations fournies lors de la création du compte utilisateur.

Info sur le compte

Permet d’entrer une date d’expiration du compte au delà de laquelle l’utilisateur ne peut plus se con-
necter, utile pour les comptes temporaires. Il est aussi possible de verrouiller temporairement un compte
afin d’empêcher un utilisateur de se connecter. Cet onglet vous permet aussi de changer l’icône associée
à l’utilisateur.

Information sur le mot de passe

Permet d’entrer un délai d’expiration du mot de passe au delà duquel l’utilisateur devra changer de mot
de passe.
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Groupes

Affiche la liste des groupes disponibles et permet de sélectionner les groupes auxquels l’utilisateur peut
appartenir.

Pour revenir à l’exemple de nos deux utilisateurs, il suffit de rechercher l’entrée fileshare et de la sélection-
ner. Cliquez sur le bouton OK pour rendre vos modifications effectives.

8.6. Sauvegarde et restauration de fichiers

Cet outil vous permet de sauvegarder les données présentes sur votre ordinateur sur différents
supports, et sur une machine distante d’un réseau. Il gère les profils multiples pour différents
scénarios de sauvegarde. Une fois les paramètres définis, des sauvegardes peuvent être faites
périodiquement. Vous pouvez alors l’oublier jusqu’à ce que vous souhaitiez restaurer des fi-
chiers.

8.6.1. Exemple concret avec l’assistant

Démarrez Drakbackup en cliquant sur l’icône Sauvegardes de la section Système de Centre de contrôle Mandriva
Linux. Lancez l’assistant en cliquant sur Configuration par assistant. Cliquez sur Suivant après chaque étape.

8.6.1.1. Première étape : que sauvegarder

Figure 8-8. Sélection des fichiers

Choisissez Sauvegarder le système pour inclure le dossier /etc. Tous les fichiers de configuration de votre
système s’y trouvent. Sélectionner cette option permet de reproduire facilement votre système sur un autre
ordinateur. Seuls les fichiers de configuration relatifs au matériel devront être mis à jour.

Note : La sauvegarde du système n’inclut pas les applications (exécutables et bibliothèque) car vous avez probablement
accès aux médias d’installation du système. Vous pouvez donc facilement réinstaller les programmes sur l’ordinateur cible.
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Sélectionnez Sauvegarder les comptes utilisateurs pour inclure tous les fichiers présents dans les répertoires
/home. Sinon, cliquez sur Sélectionner individuellement les utilisateurs et vous aurez également les options sui-
vantes :

• Ne pas inclure le cache du navigateur. Nous vous recommandons de choisir cette option en raison de la nature
même du cache des navigateurs, qui change en permanence.

• Utiliser des sauvegardes différentielles/incrémentales. Sélectionner cette option n’effacera pas les anciennes sau-
vegardes. Utiliser des sauvegardes incrémentales permettra de ne sauvegarder que les fichiers qui ont été mo-
difiés ou ajoutés depuis la dernière sauvegarde. Utiliser des sauvegardes différentielles permettra de ne sau-
vegarder que les fichiers qui ont été modifiés/ajoutés depuis la première sauvegarde (aussi connue comme
la sauvegarde de « base »). Cette option requiert plus d’espace que la première. Elle permet cependant de
restaurer le système dans l’état dans lequel il était lors de chaque opération de sauvegarde différentielle.

8.6.1.2. Deuxième étape : où stocker la sauvegarde

Figure 8-9. Sélection de l’emplacement de la copie de sauvegarde

Tous les médias de sauvegarde possibles sont listés et associés à un bouton Configurer permettant de changer
des options dépendant du média choisi :

Disque dur

Le disque dur local est utilisé pour préparer les sauvegardes pour tous les médias sauf pour NFS et les
sauvegardes directement sur bande. Vous ne devriez pas faire de sauvegarde sur votre disque dur local
de toute façon, vous devriez toujours faire vos sauvegardes sur des médias distants ou amovibles. Vous
pouvez définir le répertoire de stockage et limiter son espace. Vous pouvez aussi fixer le nombre de jours
pendant lesquels les sauvegardes incrémentales et différentielles seront conservées, afin d’économiser de
l’espace disque.

Par réseau

Pour stocker la sauvegarde sur un ordinateur distant accessible de plusieurs façons. Vous pouvez régler
les paramètres de connexion ainsi que la méthode d’accès et ses options (si disponibles). Notez que les
sauvegardes NFS sont considérées comme des sauvegardes sur disque local même si elles sont effective-
ment stockées sur un système distant.
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Sur lecteur de Bande

Vous pouvez régler le périphérique de bande s’il n’est pas détecté automatiquement ainsi que les paramè-
tres de la bande tels que l’écriture directe sur la bande, rembobiner la bande ou non, supprimer et éjecter
la bande.

Sur CD-R

C’est le média que nous avons choisi dans notre exemple. Cliquez sur le bouton Configurer pour régler les
paramètres requis (voir figure 8-10).

Figure 8-10. Paramétrage des médias optiques

Si le périphérique n’est pas automatiquement configuré, utilisez la liste déroulante Choisissez votre lecteur
CD/DVD. Réglez le type et la taille du média ainsi que les options de multisession et d’effacement.

Pour les enregistrements multisessions, gardez à l’esprit que l’option qui permet d’effacer un support n’est
effective que lors de la première session et que l’information relative à la session nécessite de l’espace (environ
20 à 30 Mo pour chaque session). Donc, l’espace de stockage disponible pour les données de sauvegarde sera
inférieur à la taille du support.
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8.6.1.3. Troisième étape : résumé et enregistrement des paramètres de configuration

Figure 8-11. Configuration de sauvegarde

La dernière étape de l’assistant montre un résumé des paramètres de configuration. Utilisez le bouton Précé-
dent pour modifier les paramètres dont vous n’êtes pas satisfait. Cliquez sur Enregistrer pour les stocker dans
le profil Défaut. Le jeu de sauvegarde est maintenant prêt à être exécuté.

Profils de sauvegarde

Vous pouvez cliquer sur le menu Fichier→Enregistrer le profil sous et saisir un nom de profil pour stocker les
paramètres de sauvegarde actuels dans un profil de sauvegarde qui portera le nom que vous avez saisi. Vous
pouvez ensuite relancer l’assistant de configuration, définir d’autres paramètres et les stocker dans un profil
différent.

Utilisez l’option --profile Nom_du_Profil.conf quand vous exécutez Drakbackup en ligne de com-
mande pour charger le profil Nom_du_Profil.conf.

8.6.1.4. Effectuer la sauvegarde

Cliquez sur le bouton Sauvegarder, assurez-vous que le support correspondant est prêt (le CD réinscriptible
dans notre exemple), puis cliquez sur le bouton Sauvegarder à partir de la configuration définie.

Avertissement

Si la taille de la sauvegarde dépasse la capacité du support, l’opération de sauvegarde pourrait échouer. Tentez de
retirer des fichiers de la liste de sauvegarde de manière à ne jamais excéder la capacité du support.

Une fenêtre affichant la progression de l’opération s’affiche. Soyez patient : le temps nécessaire à la sauvegarde
dépend de nombreux facteurs tels que la taille des fichiers à sauvegarder, ou la vitesse du média de stockage.
Une fois la sauvegarde effectuée, un résumé s’affiche. Recherchez-y les erreurs éventuelles et corrigez-les.
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8.6.2. Restauration des sauvegardes

Figure 8-12. Choix du type de restauration à effectuer

Assurez-vous que le support contenant la sauvegarde à restaurer est prêt et accessible. Cliquez sur Restaurer.
Dans notre exemple, nous restaurons l’intégralité de la sauvegarde. Dans la fenêtre de restauration (figure
8-12), cliquez sur Restaurer toutes les sauvegardes puis sur Restaurer pour démarrer la restauration.

Avertissement

Les fichiers existants dans le dossier où la restauration aura lieu seront écrasés. Par défaut, ce dossier est le même
que celui utilisé lors de la sauvegarde.

N’hésitez pas à explorez les autres options de restauration si vous souhaitez ne restaurer qu’une partie d’une
sauvegarde plutôt que tout l’ensemble de fichiers, ou restaurer la sauvegarde à un autre endroit.

8.6.3. Automatisation des sauvegardes périodiques

Dans la fenêtre principale, cliquez sur Configuration manuelle puis sur Quand. Dans la fenêtre de programma-
tion des sauvegardes (figure 8-13) choisissez Sauvegarde périodique pour définir la fréquence de la sauvegarde.
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Figure 8-13. Paramètres du robot

Vous devez alors spécifier l’intervalle (ou la période) entre chaque opération de sauvegarde ainsi que les sup-
ports de stockage. Dans notre exemple, nous avons défini un calendrier personnalisé (personnalisé sélectionné)
pour effectuer une sauvegarde du mercredi au vendredi à 23 heures 45 minutes, sur un CD, en utilisant le
profil de sauvegarde Défaut.

8.6.4. Configuration avancée des sauvegardes

Cliquez sur le bouton Configuration manuelle puis sur le bouton Plus d’options pour régler des options supplé-
mentaires (figure 8-14).

Figure 8-14. Options diverses

Programme d’Archivage

Vous avez le choix entre tar (choix par défaut) et star qui vous permet de sauvegarder aussi les ACL
étendues.
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Type de compression

Pour la stratégie de compression à utiliser lors de vos sauvegardes, vous avez le choix parmi : tar (aucune
compression), tar.gz (compression gzip) et tar.bz2 (compression bzip2: plus efficace mais plus
lent).

Fichiers à ignorer

Certains fichiers peuvent être exclus de la sauvegarde. Les fichiers .backupignore doivent être présents
dans chaque dossier où des fichiers doivent être exclus de la sauvegarde. Sa syntaxe est très simple : le
nom de chaque fichier devant être exclu doit y être présent (un nom de fichier par ligne).

Astuce : Vous pouvez utiliser une étoile (* signifie toute châıne de caractère ) et un point d’interrogation (?
signifie un, et un seul caractère, quel qu’il soit ) dans le fichier .backupignore pour exclure plusieurs fichiers. Par
exemple, abc* correspondra à tous les fichiers commençant par abc. image00?.jpg correspondra aux fichiers
nommés image001.jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.

Envoi de rapports par courriel

Indiquez l’adresse de courriel à laquelle un rapport de l’opération sera envoyé. Vous pouvez indiquer plu-
sieurs adresses de courriels séparées par une virgule (,). Remplissez aussi le champ Adresse de l’émetteur
du courriel avec l’adresse de l’administrateur des sauvegardes ainsi que le champ Serveur SMTP pour le
courrier avec le nom ou l’adresse IP du serveur de courriers sortants.

Suppression des fichiers temporaires

Cochez l’option Effacer les fichiers tar après sauvegarde vers un autre support pour libérer cet espace après
la sauvegarde.

Visualiser le journal de restauration

Vous pouvez visualiser le journal de restauration après chaque restauration. Cela peut être utile pour
identifier et réparer les problèmes qui peuvent éventuellement survenir lors d’une restauration de
fichiers : erreurs de lecture, erreurs de communication réseau, etc.
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9.1. DrakFirewall : configuration d’un pare-feu élémentaire

Cet assistant vous guidera à travers le processus de configuration d’un pare-feu sur votre ma-
chine. Il filtrera les tentatives de connexions extérieures, et bloquera celles qui ne seront pas
autorisées. Il est recommandé de le lancer juste après l’installation de votre système et avant
de vous connecter à Internet, ce qui minimisera les risques d’intrusion sur votre machine.

Cet assistant comporte trois étapes que nous détaillons ci-dessous..

9.1.1. Choisissez les services accessibles depuis l’extérieur

Figure 9-1. La boîte de dialogue de DrakFirewall

Ouvrez les ports, si nécessaire. Si elle est cochée, décochez la case Tout (pas de firewall), puis cochez les cases
correspondant aux services que vous souhaitez rendre disponibles pour le monde extérieur. Si vous souhaitez
autoriser un service qui n’est pas listé ici, cliquez sur le bouton Avancé pour pouvoir entrer manuellement le
numéro de port à ouvrir.

Ouverture de services peu communs : Le bouton Avancé va rajouter un champ Autres ports dans lequel vous pourrez
rentrer n’importe quel port que vous souhaitez laisser ouvert pour l’extérieur. Des exemples de spécifications de tels ports
sont affichés juste au-dessus. Il est aussi possible de spécifier une plage de ports à l’aide de la syntaxe : par exemple :
24300:24350/udp

Cela ne vous empêchera pas d’accéder à Internet. Le fait de ne pas cocher un service de cette liste ne vous
empêchera pas de vous y connecter. Par contre, les utilisateurs externes ne pourront pas se connecter à ce
service sur votre machine. Si vous pensez n’héberger aucun service sur votre machine (cas le plus courant
pour une simple machine de bureau), décochez toutes les cases.

Comment désactiver le pare-feu. D’un autre côté, si vous souhaitez désactiver le pare-feu et laisser ouvert
l’accès à tous les services depuis l’extérieur, cochez Tout (pas de firewall), mais gardez à l’esprit que cela est
très dangereux, et par conséquent déconseillé.
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9.1.2. Activez le pare-feu interactif

Figure 9-2. Options du pare-feu interactif

Soyez informé des tentatives de connexion à votre machine.

Le pare-feu interactif peut vous avertir des tentatives de connexion à votre machine, en affichant un message
d’alerte avec l’applet du réseau. Cochez l’option Utiliser le Pare Feu interactif pour activer cette fonction.

Détection de balayage de ports

Activez cette option pour être averti des tentatives d’accès malveillantes à votre machine.

Autres entrées correspondant aux ports ouverts

Ensuite, une case apparaît près des ports que vous avez choisi d’ouvrir à l’étape précédente. Si vous les
activer, un message d’avertissement apparaîtra chaque fois qu’une tentative de connexion sera effectuée
sur ces ports.

9.1.3. Quelle interface protéger

L’étape suivante consiste à choisir l’interface réseau connectée à Internet.
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Figure 9-3. L’interface Internet

Si vous ne savez pas laquelle de vos interfaces est connectée à Internet, vous pouvez jeter un oeil à la confi-
guration réseau du système (Reconfiguration d’une interface, page 91). Enfin, cliquez sur OK pour installer les
paquetages nécessaires, activez le pare-feu et appréciez une connexion à Internet sécurisée.
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Mandriva vous propose un service utile pour que vous soyez prévenu dès que des correctifs de bogue ou de
trou de sécurité qui concernent votre installation sont disponibles. Ce service peut également être paramétré
pour installer automatiquement les paquetages de mises à jour, sans que vous ayez à les installer manuelle-
ment.

Ce système se compose des éléments suivants :

Assistant de configuration initiale (voir Configuration de départ, page 115)

Permet d’enregistrer une nouvelle machine.

Interface de gestion Web (voir L’interface Web de gestion, page 116)

Permet de gérer la liste des machines que vous administrez et d’activer les machines qui sont concernées
par les mises à jour.

Une applet (voir L’applet Mandriva Online, page 118)

Permet d’être rapidement informé sur l’état actuel des mises à jour et d’en lancer l’installation si néces-
saire.

Pour plus de renseignements sur le service Mandriva Online, consultez la FAQ de Mandriva Online (https:
//www.mandrivaonline.com/page.php?page=info).

10.1. Configuration de départ

L’assistant Mandriva Online s’affiche lorsque vous démarrez votre système après son installation. Ceci per-
met de créer un nouveau compte ou d’enregistrer un compte existant. Vous pouvez aussi lancer cet assistant
manuellement en cliquant sur l’icône Mandriva Online du tableau de bord, puis en choisissant Configurer main-
tenant !. Vous devez entrer le mot de passe root.

Figure 10-1. Compte existant ou inscription à Mandriva Online

Après avoir cliqué sur Suivant, choisissez l’option appropriée à votre situation (J’ai déjà un compte ou Je veux
m’inscrire) et cliquez sur Suivant.

115

https://www.mandrivaonline.com/page.php?page=info
https://www.mandrivaonline.com/page.php?page=info


Chapitre 10. Service Mandriva Online

Figure 10-2. Authentification sur Mandriva Online

Saisissez maintenant votre identifiant (login) et un nom pour identifier la machine depuis laquelle vous tra-
vaillez. C’est utile si vous administrez plusieurs ordinateurs avec Mandriva Online.

L’étape suivante rassemble un certain nombre d’informations sur votre ordinateur. Ceci est nécessaire pour
que les services fournis soient opérationnels.

Figure 10-3. Envoi de votre configuration

Pour finir, vous devez choisir votre pays de façon à ce que les mises à jour proviennent du serveur le plus
proche possible. Si votre pays n’est pas listé, choisissez le pays le plus proche. Cliquez sur Suivant puis Terminer
pour quitter l’assistant.

Pour continuer la mise en place de votre service Mandriva Online, vous devez maintenant activer cette machine
dans votre compte.
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10.2. L’interface Web de gestion

Pour activer votre compte Mandriva Online, faites un clic droit sur l’applet Mandriva Online et choisis-
sez Site Mandriva Online. Une fois sur l’interface Web d’administration Mandriva Online (https://www.
mandrivaonline.com/), entrez votre adresse de courriel et mot de passe.

Note : Vous pourrez aussi consulter le paramètrage de votre espace personnel (https://my.mandriva.com) sur le site
Internet My Mandriva.

10.2.1. Activation de nouvelles machines

Figure 10-4. Liste des machines Mandriva Online

10.2.2. Gestion des machines

Lorsqu’une machine est active, vous pouvez accéder à son interface de gestion en cliquant sur l’icône détails.

Figure 10-5. Mandriva Online pour une machine à jour

Les contrôles sont un peu différents selon que les paquetages RPM de votre machine sont à jour ou non, mais
les possibilités de base sont les suivantes :

Notification par e-mail

Cliquez sur le lien oui pour valider l’envoi de notification de mises à jour.

Mises à jour automatiques

Cliquez sur le lien oui pour que les mises à jour automatiques soient installées par l’applet (L’applet Man-
driva Online, page 118), qui se connectera régulièrement sur Internet pour les détecter.

État actuel des paquetages

Cliquez sur le lien See devant le paramètre Installed packages, ou Errata(s).
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10.2.3. Planification des mises à jour

Vous pouvez mettre à jour votre ordinateur manuellement en utilisant l’applet (voir L’applet Mandriva Online,
page 118). En consultant l’interface Web, vous pouvez identifier les mises à jour disponibles et choisir celles
que vous voulez installer.

Figure 10-6. Mandriva Online pour une machine qui n’est pas à jour

Vous devez choisir les paquetages à mettre à jour. Vous pouvez le faire en une seule fois, en cliquant sur le
bouton Schedule all packages to be updated button, ou bien en les sélectionnant un à un en cliquant sur le bouton
Errata(s): See link.

Figure 10-7. Sélection des paquetages à mettre à jour

Pour obtenir une description complète du contenu de cette mise à jour, cliquez sur la référence (MDKA-
année:nombre ou MDKSA-année:nombre). Cochez la case correspondant à chacun des paquetages que vous
souhaitez mettre à jour sur votre machine. Ensuite, cliquez sur le bouton Schedule Packages.

Une fois sélectionnées, les mises à jour seront automatiquement installées lors d’une prochaine connexion de
l’applet au serveur Mandriva Online, ce qui intervient plusieurs fois par jour.
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10.3. L’applet Mandriva Online

Cette applet installée dans le panneau de contrôle de votre poste de travail fournit des informations sur la
disponibilité des mises à jour, et permet d’exécuter des tâches simples de maintenance du système.

Le bouton de l’applet affiche différentes icônes suivant son état :

Le système est à jour, tout va bien.

Une mise à jour standard est disponible pour un des paquetages installés.

Une mise à jour relative à un correctif d’erreur (bogue) est disponible.

Une mise à jour relative à un trou de sécurité est disponible. Il est vivement recommandé
d’installer au plus tôt ce type de mise à jour.

L’applet tente actuellement de contacter le serveur, patientez.

Cet hôte n’est pas activé. Vous pouvez l’activer en utilisant l’interface Web (voir Activation de
nouvelles machines, page 117).

L’applet n’arrive pas à se connecter au serveur. Vérifiez votre connexion Internet.

Le système n’est pas configuré ou une erreur de configuration l’empêche de fonctionner.
Lancez à nouveau l’assistant de configuration (voir Configuration de départ, page 115) pour
pouvoir utiliser Mandriva Online.

En cliquant sur l’icône de l’applet s’ouvre un écran qui propose des actions et qui affiche l’état actuel de la
machine.

Figure 10-8. Applet Mandriva Online

Installation des mises à jour

Pour lancer manuellement l’assistant d’installation des mises à jour, en ouvrant Rpmdrake (voir Installation,
suppression et mise à jour de logiciels, page 58).

Configurer

Pour lancer l’assistant d’initialisation de la configuration de départ (Configuration de départ, page 115).
Ceci peut être utile pour renvoyer la configuration de votre machine au serveur.

Vérifier la disponibilité de mises à jour

Pour forcer une connexion au serveur et vérifier si des mises à jour sont disponibles. Ceci est fait pério-
diquement par l’applet, mais si vous n’avez pas de connexion permanente à Internet, cette fonctionnalité
vous permet de vérifier la disponibilité des mises à jour lorsque vous vous connectez.
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